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“Education is a matter of life and death for
Pakistan., The world is progressing so rapidly
that without requisite advance in education, not
only shall we be left behind others but may be
wiped out altogether.”

(Seplembar 26, 1947, Karachi} Quaid-e-Azam
Muhammad Ali Jinnah
Founder of Pakistan
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Physically a computer is a ccmblnaﬁm] of different hardware devices
such as System Unit, Monitor, Keyb-ﬂnrd, Mouse and Printer, etc. In this
unit students will learn about system unit and its internal components
such as Motherboard, Processor, RAM, ROM, Expansion Cards and
ansion Slots etc. Students will also learn breifly about cutting edge
ogies such as Barcode Reader, Fingerprint Reader and Robots.

Learning Outcomes:

After completing this unit, students will be able to;

¢ define system unit.

o recognize and explain Motherboard and Processor
( Control Unit and Arithmetic Logic Unit ).

o explain Memory ( RAM and ROM ).

@ recognize and explain Expansion Cards
and Expansion Slots.

& explain briefly Barcode reader, Fingerprint reader
and Robot. :




Introduction to Hardware

In the previous class we have already studied the definition of computer and its
basic components, we will review them here.

“A Computer is an electronic machine which processes raw data (input)
into meaningful information (output) and also stores output for later

use.

A computer works with the help of its components, The components of a
computer consist of hardware and software.

Components of a Computer

|
| R

Software Hardware

Software

Software is the set of instructions given to the computer to perform a
specific task. A software is also called a computer program. For example
Microsoft Windows, M5 Word, Corel Draw, Device drivers, etc.
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Introduction to Hardware Basics

Hardware

The physical parts of the computer that we can see and touch are known as
hardware. These include the input and output devices as well as the system unit.

@ Input devices: Devices which are used to enter data into a computer are
known as input devices, e.g. Keyboard, Mouse, Microphone, Scanner, Digital

Camera, etc.
S TLLLLET
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_ Keyboard Digital Camera

@ OQutput devices: Devices which are used to display.l'present output are
called output devices, e.g. Monitor, Printer, Speakers, etc.

a 5= N

Monitor Speakers
@ Storage devices: Storage devices hold data and instructions permanently
e.g. Floppy disk, Hard disk, CD/DVD, USB Flash drive, etc.

o
4
w
——
Floppy Disk Hard Disk CD USB Flash Drive

@ Communication devices: Devices which are used to communicate and
connect a computer with other computers are known as communication

devices e.g. Modem.
9.‘.‘-‘3- b

Internal Modem External Modem
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1.1 System Unit

System unit is a box where processing takes place. It consists of the main circuit
board, processor, power supply, storage devices,etc. It can be found in different

shapes and sizes. System unit protects internal electronic components from
damage.

Power Supply
Fig. 1.1 System Unit and its Components

Usually in Personal computers, System Unit can be found in two shapes.

Tower Shape

B Vot For Sale - PESRP



1.1.1 Motherboard

Motherboard or System board is a main circuit board. All the computer
components are plugged or connected with it.

Following are some of the hardware components attached to the motherboard.

@ Processor o~ _ ~

@ Input/Output devices :

@ Memory Chips (RAM, ROM) The i"'I:"-it and ‘output devices are
connected externally through cables

@ Expansion Cards to the system unit. They are known

@ Expansion Slots as.l’qﬂp'mk e.g. Mouse, Keyboard,
Monitor, Printer, etc.

@ Storage devices WX : o

ECI Slots AGP Slot
L _|_ \l

__Peripheral Ports

Fig, I.1.1 Matherboard or System board

1.1.2 Processor

Processor works like a human brain. It is a silicon chip fixed on the motherboard. Its
primary purpose is to carry out set of instructions and process the data efficiently
and accurately, It is also known as CPU (Central Processing Unit).

Not For Sale - PESRF (I



The System Unit

Arithmetic and Logic Unit (ALU)

All mathematical and logical problems are solved in this portion of the processor. it
consists of Arithmetic Unit and Logic Unit.

@ Arithmetic Unit : AU is a part of ALU. It performs mathematical operations such
as addition, subtraction, multiplication and division.
Forexample:2+2=4 or 4-1=3

@ Logic Unit : LU is also a part of ALU. It compares two quantities and gives
answer in the form of true or false.
Forexample: (5+3)=8 True
(5+3)=7 False
5=3 True
5<3 False

I Not For Sale - PESRP



Control Unit

The control unit controls, co-ordinates and directs all
the operations performed by the computer. it does
not execute any instruction itself but directs the other
parts of the computer to carry them out.

It works like a traffic policeman who controls the
movement and flow of traffic. Similarly, Control Unit
maintains the sequence and flow of instructions

which are to be processed.

1.1.3 Memory

Memory consists of electronic chips. Memory stores Instructions and data so that
CPU can process them. It is the working space of the computer.

Memory has two types.
@ RAM ( Random Access Memory )

@ ROM ( Read Only Memory )

RAM ( Random Access Memory )

RAM stands for Random Access Memory. It is a temporary storage area for data
before and after it is processed. It is attached to the motherboard. RAM is volatile,
i.e. information is lost when the power is switched off. For example, someone is
typing a letter on the computer and the power goes off, the contents of the letter

will be erased from RAM if it is not saved.

Fig. 1.1.3a RAM is plugged in a socket

_'m-. and S - . o
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the numbers 3 and 4, along with | ——"1 numbers and the instruction

You use an input device ta i ut | The processor retrievies the
P np |

|

| | theinstruction ADD.

| toperform the addition.

“ | EB The result,7, is |
\"\E temporarily held In
-: memory. From here |t

| can be output ar stored.

| | I The numbers and the instruction |
are temporanily held in memory, |

\ Fu- I.1.3b Execution cvele of a single Instraction,

m{neado-lymmyl

ROM stands for Read Only Memory. It is a permanent storage area. It contains start up
instructions of the computer and information about its hardware devices. It is fixed on
the motherboard.

ROM is nonvolatile, i.e. information is not lost when the power is switched off. Data
cannot be changed or removed from the ROM, that is why it is called read only memory.

Fig. L1.3c ROM
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1.1.4 Expansion Cards
An expansion card is a small circuit board. It gives a computer the capability to control
a storage device, an input device or an output device, Basic purpose of an expansion

card is to enhance the capability of the computer.
There are four major types of expansion cards.

|) Sound Card:
A sound card allows a computer to receive sound
in digital form and reproduce it through speakers.

| Speakers, headphone and micro-
| phone are attached here.
s aem g ST Fig. I.1.4a Sound Card

2) Graphics Card:
A graphics card enables a computer to
display output images an the manitor

screen. R,
| Monitor is attached here. :,
Fig. 1.1.4b Graphics Card
3) Network Interface Card:
A network interface card enables a computer to _
connect and communicate mi_j; gmg__r computers. :
el e
Network cable s attached here, = :
¢ —

Fig 1.1.4c Netwark Interface Card

4) Modem: LT
Modem is used to transmit digital data over
telephone wires. Usually it is used for dial-up
Internet connections.
) o /... >
| Telephone cable is attached here. = ==

Fig 1.1.4d Modem
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The System Unit

1.1.5 Expansion Slots

An expansion slot is a long narrow socket on the Motherboard into which
different expansion cards can be plugged in. There are three different types

of expansion slots i.e.
1) ISA ( Industry Standard Architecture )
Itis a slow speed slot used for modems ( Rare to find in modern computers),
2) PCI ( Peripheral Component Interconnect )
Itis faster in speed than ISA slot. It is used for sound cards, graphic cards, network
cards and Modems.

3) AGP ( Accelerated Graphics Port )
Itis a high speed slot used only for graphics/3D graphics cards.

Fig. 1.1.5 Expansion Slots

B Not For Sale - PESRP



Li Y W TR W

Cutting Edge Techﬁolagies

1.2 Cutting Edge Technologies

The latest or the mcst advanced stage in the development of the computer technology
isknown as cutting edge technology.

1.2.1 Barcode Reader

Barcode is a set of light and dark bars (lines) with
different width pasted on different products.
Barcode Reader is an input device. It gathers

Information by reading a barcode.

Every barcode has a series of numbers known as
Universal Product Code (UPC).
It refiects the country of origin, ‘
:
|

manufacturer's code, product’s
name and check digit (to verify
code).

Fig, 1.2.1a Barcode Reader

Barcode Reader is a laser scanning device. Usually, a Barcode Reader Is attached to a

computer. It translates the information stored in the form of a barcode. This information
includes batch number and product name etc. Barcode readers are mostly used in

supermarkets, pharmacy, libraries, etc. (\

Hand handled
Barcode Reader

Laser beamed
Barcode Reader

-

Fig, 1.2.1b Different Barcode Readers
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Cutting Edge Technologies

1.2.2 Fingerprint Reader

A fingerprint is an impression left by a finger or thumb. Fingerprint Reader is a device
that captures a fingerprint and translates it into a digital code. This code is compared
with the already stored information in the computer

Ridges

Fig. 1.2.2a Thumb Impression

Fingerprint reader is mostly used for criminal investigations and security systems.
Some computers use it for login and user’s authentication.

Fingerprint reader is used to Jogin a computer,

Fingerprint reader is used in a car security
sysiem.,

Fingerprint reader is used
for employvee's attendance, door lock for home security,
Fig. 1.2.2b Different uses of fingerprint reader

Fingerprint reader is used in a

I \ot For Sale - PESRP



1.2.3 Robots

Robot is a machine which is controlled by a software contained in a chip. Robots are
made to help human beings. It is an electronic machine which has the ability to
interact with physical objects. They are also known as mechanical agents.

Robots can perform tasks accurately and efficiently. They are classified on the basis of

their design and the work they do.

A dishwasher Robot A domestic Robot

Robots are used i different fields such as

car manufacturing, medicine, military,
transportation, etc.

Many factory jobs are now performed by

robots. Robotic hands are widely used in
factories. NASA Is using robots for space
exploration.

Robots are doing surface exploration Robots are used in surgery. Robotic hand is welding

on the MARS, in the factory.
Fig, I.2.3 Different Robots
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Summary

System Unit is a box where processing takes place.

Motherboard is a main circuit board. All the computer components are
plugged or connected with it.

Processor carries out set of instructions and processes the data efficiently and
accurately. It is also known as CPU. The two main components of a processor
are ALU (Arithmetic and Logic Unit) and CU (Control Unit).

Arithmetic and Logic Unit solves the mathematical and logical problems.
Arithmetic Unit performs addition, subtraction, muitiplication and division.
Logic Unit compares two quantities and gives answer in the form of true or false.

Control unit fetches the instructions, interprets them and directs the ALU to
perform action. It also maintains the sequence of instructions to be processed.

Memory consists of electronic chips. It stores instructions and data so that CPU
can process them. It is the working space of the computer.

RAM stands for Random Access Memory. It is a temporary storage area for
data before and after it is processed. It is attached to the Motherboard.

ROM stands for Read Only Memory. It Is a permanent storage area. It contains
start up instructions of the computer and infermation about its hardware devices.

An Expansion Card is a small circult board. It gives a computer the capability to
control a storage device, an input device or an output device.

Expansion Slot is a long narrow socket on the Motherboard into which different
Expansion Cards can be plugged in.

Cutting Edge Technology is the latest or most advanced stage in the development
of the computer technology.

Barcode Reader is an input device. It gathers information by reading barcodes.

Fingerprint Reader is a device that captures a fingerprint and translates it into
a digital code. This code is compared with the already stored information in the
computer.

Robot is a machine which is controlled by software contained in a chip. Itis an
electronic machine which has the ability to interact with physical objects.

I Not For Sale - PESRP



Hardware Basics

Q.1 Tick the correct choice.
i) Physical parts of a computer are known as :

&) Software b) Hardware ¢) Operating Systern  d) System Unit

i is a place where processing takes place.

a) Box by CPL c) Maonitor d) System Unit

iii) Processor is fixed on the

) Far b Chipboard o) Motherboard d) Expansion Slot

iv) There are types of memory .

a) Two b} Three c) One d) Four

v) A Processor acts like afan

a) Heart ) Arm ¢) Brain di Kidney

vi) A processor is also known as

a) CPL b) LIPS ) UPC d) PLS

vii) Arithmetic operations are performed by

a) LU b) AU ) ALU d) CU
viif) Which one of the following pars of the CPU controls the sequenice of the instriictions? °

a) Al bl CuU ¢y LU d) ALL

i%) RAM stands for :

a) Random Access Memory ) Randam Analysis Method

¢’ Read Able Memory d} Random Avallable Memory

x) ROM stores data

a) Permanently b) Ternpoararily ) Partially d) Fully
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Hardware Basics

xi) Which of the following is the highest speed slot?

a) ISA b) AGP o) PCl d) APG
xii) A video game is played by using card.
a) Sound b) Modem ¢) Graphics d) Network Interface
xiii) Barcode Reader is a/an device.
a) Output b) Input ©) Display d) Storage
Xiv) is used in security systems and criminal investigations.
a) Fingerprint Reader b) Robots ¢) Sound card d) Barcode Reader
xv) is also known as mechanical agent.
a) Computer b) Barcode Reade ) Processor d) Robots
Q.2 Fill in the blanks.
) The two main components of a Processor are and
ii) RAM is used for storage,
iii) ROM is memory.
iv) slot is a long narrow socket fixed on the Motherboard.
v) Memory consists of chips.
vi) is faster slot used for sound, graphics, Modem and Network
Interface card.
vil) slot is hard to find in modern computers.
viil) Barcode reader is a scanning device.
ix) is a device that captures a fingerprint.
x) works like a traffic policeman.

B Mot For Sale - PESRP



Hardware Basics
Q.3 Define the following.
a) System Unit

b) Memory

©) Processor

d) Barcode Reader
e) Motherboard

Q.4 Differentiate between the following.
a) Hardware and Software

b) AU and LU

¢) RAM and ROM

d) Expansion Slots and Expansion Cards

e) Input devices and Output devices

Q.5 Give brief answers to the following questions.

i) Define the brain of the computer and write down the names of its components.
ii) What are the main functions of the Arithmetic Logic Unit ?

i) What is Read Only Memory?

iv) Write down the three main uses of the Fingerprint Reader.

v) What is the main function of a Robot?

vi) How many expansion slots are there in computer? Write their names.
vii) Write the names of major Expansion Cards and explain two of them.
vill) What information is gathered from barcodes? .
ix) What is cutting edge technology? Give some examples.

x) Why RAM is called volatile memory?

Not For Sale - PESRP (i
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Hardware Basics
Q.6 Match column A with column B and write the matching pairs number in

column C,
AT B c
i) Motherboard a) CPU id
i) System unit b) AGP Slot
fii) Brain ¢) Security Systems
iv) Libraries d) Main board
v) Graphics/3d card e) CU
vi) Fingerprint Reader f) Robot
vii) Peripherals g Box
vill) Traffic Policeman h) Non Volatile
i») Mechanical Agent i) I/O devices
x) ROM j) Barcode
k) Volatile
I} Sound card

Q.7 Label the following diagram.

I Not For Sale - PESRP
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Hardware Basics

Lab Activity (Peripherals)

Write the names of peripherals which are attached to your computer.

1) 2)

3) 4)

Lab Activity (Control Unit)

Who is the control unit in a traffic system?

What does he do?

Who is the control unit in a school assembly?

What does he do?

Lab Activity (Barcode Reader)

Write the names of any five products which have barcode. Also write their Universal
Product Code (UPC) in front of each product.

Product Name UPC

Not For Sale - PESRP (I



Lab Activity (Checking Processor Speed & RAM Size)
Follow the steps:

= Right click the
My Computericon
on the Desktop.

= Click Properties.

= System Properties dialogue box

appears. =
5—. |
= Computer general information = gl .
appears showing Processor speed fi“’ { - '
and Memory size. J SRR
— s shabeen |
b
ESITHGAESTREED JTRED
=P Now write down the Processor speed Compime
and Memory size of your computer “ peiaf et
i i I6TaMe TIZME RAM |
Processor speed
Memary size \ [I} L_.:_E'-Ej
Lab Activity (Robots)

Allocate the given words/phrases to the right column.
breathing , dishwashing, thinking, walking, sleeping, welding, painting vehicles, getting tired

Things a Robot can do Things a Robot can't do

IEINot For Sale - PESRP



This unit enables students to understand software basics and its types,
system soﬂwure.&nd application software. The students will also learn
about the operating system, its basic functions, utility programs, device
drivers and different types of application software.

Learning Outcomes:

After completing this unit, students will be able to:
define system software.
know the basic components of system software.
define operating system and its basic functions.

define device drivers. g
define Utility programs, File manager, Image viewer _f_g

and Disk scanner. —
define application software. U

distinguish among different kinds of application W' d
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Introduction to Software

Computer cannot perform any task with the hardware alone. It requires instructions
to perform a task. These instructions are called Software.

“Software is the set of instructions given to the computer to perform a
specific task”,

Software are designed to help users to interact with computer, create documents,
play games, watch movies, draw images and paintings etc. There are two main types

of software,
Software

| |
| |
System Software Application Software

2.1 System Software

System software are programs that control and direct the operations of a computer
hardware. These software are essential part of the computer system. A user cannot
work on a computer without system software.
There are different types of system software, few important ones are being discussed
below.

@ Operating Systems

& Device Drivers

& Utilities/Utility Programs

2.1.1 Operating System (OS)

Operating System is a system software. It is just like the soul of a computer. It is a
collection of programs that supervises and controls overall functions of a computer.
Operating System also organizes all the data and runs other applications in a
computer It creates a link between a user and the computer.

Microsoft Windows is the most widely used operating system for personal
computers. Linux, Unix and Mac OS are some of the other operating systems.

W23, | Not For Sale - PESRP



Important Functions of the Operating System

Some of the important functions performed by an operating system are given below.

Manages the startup process.
System files of the operating
system are loaded in RAM.

Manages file and disk
operations such as saving,
retrieving, deleting files
and formatting disks.

Dperating system helps a user
to work with multiple programs
and applications simultaneously.

Controls the fiow O
input and output operatio
and configures devices.

Fig. 2.1.1 Basic Functions of an Operating System
@ Booting and providing a User Interface
Operating system manages the start up process of a computer. It loads the system
files in the RAM of the computer and provides a user interface so that the user
can easily work on the computer.

& Managing Programs
Operating system helps a user to work with multiple programs and applications
simultaneously. It manages multiple applications by showing active application in
foreground and other programs in the background. User can easily switch through
these applications by clicking their buttons on the taskbar

&  File Management
Operating system allows a user to manage files and folders. The user can
create, save, delete, copy, cut, paste and rename the files and folders easily.

& Configuring Devices
When a computer starts, operating systém checks all the devices and loads
their drivers. When a new device is attached to the computer, operating system
configures it and Installs its driver so that it can work properly.

Not For Sale - PESRp (25N
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2.1.2 Device Drivers

A device driver is a system software that tells the operating system how to
communicate with a device. It is also known as a driver. Most of the device drivers are
automatically installed with the Microsoft Windows. A device can't work properly if
device driver is not installed e.g. device driver of printer, modem, sound card, etc,

2.1.3 Utility Programs
Utility program is a system software that allows a user to analyze, configure and

maintain the computer. It performs a specific task related to the management of
computer, its devices and files/programs.

In Microsoft Windows there are different Utility programs such as Disk cleanup,
Windows Explorer, Windows Picture and Fax Viewer, Backup, Security Center, Add
or Remove Programs, etc.

Different Utility Programs in Windows
=% Click Start button.

“* Point to All Programs.

= Point to Accessories and then point to System Tools.

24 NotFor Sale
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Fig. 2.1.3a Different Utility Programs in Windows
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FiIe Manager

File Manager is a utility program that helps user to locate, rename, move, copy and
delete files. In Windows operating system Windows Explorer serves as a File manager.
Using Windows Explorer to Rename a File

=~ Open Windows Explorer from Start menu.

~'~  Windows Explorer appears with My Documents folder.

This area shows the
s,
Right click on My Documents. contents of the

«~ A Task Pane appears. selected folder.

nmhn—umﬂﬂ

00 8|pp@

All the folders | i &
appear here. oW 1 L,) ilfeii
S
| |
zl
= (Click Rename, Fig. 2.1.3b My Documents Window

=% Now Rename My Documents as you like.
( Ali's Documents, Asma’s Files etc.)

]
Image Viewer
Image viewer is a utility program that provides an environment to view and manage
images in the same folder or location. In Microsoft Windows, this utility program comes
with the name of Windows Picture and Fax Viewer:
While using this program the user can view, copy, move, print, edit, rotate, zoom and
delete an image. It also gives an option to view all the images in the same location in a
slide show.
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Using Image Viewer
=% On the desktop, double click My Dacumenml

Fig. 2.1.3¢ Deskrop
=% My Documents window appears.

=% Click My Pictures.

Fig. 2.1.3d My Document Window

=% Open Sample Pictures.

260 Not For Sale - PESRP
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i e sh fodder

Fig. 2.1.3e Sample Pictures folder
=% Double click any picture.

=% Picture opens in Windows Picture and Fax Viewer:

s Blue hills - Windows Picture and Fax Viewsr 1 |

mm:*-:'ﬂ‘:’ B P aa )(-Hﬂqy

P 5 B 2
Prg ﬁﬂ,‘f@vfﬁ S

qﬁ "l-\'_-‘

q.
Fig. 2.1.3f Windows Picture and Fax Viewer
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Disk Scanner utility is used to detect physical and logical problems of a disk. It checks
the disk and resolves the errors. It also searches the disk and removes unnecessary
files. In Windows, Disk Cleanup utility program searches the disk for unnecessary files
and allows a user to delete them safely

Using Disk Cleanup
= Click Start button.
Point to All Programs =» Accessories =» System Tools
= Click Disk Cleanup. —— P

e Hmmnln:hn
J vl Adrninistr e Wil Cotalog
— @ Windows Lndate

QRS
o eser
) Games

o Reue 3 iaderess Euok,
R it = Wit Expioor 5 Caleulster
! @ i '-ﬁ L] B Command Promer
i Ontlook Express W Metscad
3.;' Crow CAPTLRE 14 | 5. Pemole Assctarey W Pue
; (5} Winmiows Medhe Plaver 5 Progran Comoalibiity iosrd
‘\‘!HSH 4 Wi Mensorger 1 Syrchiones
) Wandoe Mo Maker i.a Tous Warciess

| @mmm ) CoelDRAW Greptis Sae Xt ¥ | L7 Wandewns Exlorer
§ B ndobe Photodron 7.0 A o
) Mernsoft Offics
] Mobis Patrer
Al Programs B ) EVDOEROADEAND FICL L

Fig. 2.1.3g Start Menu

= Disk Cleanup dialogue box appears.

= Selectthedrive —— ;::ﬂ-dmwmmnhmm
which you want to L B .
cleanup. -
L ox [ e ]
= Click OK. e
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Fiiaz to delete:
[7] ) Tomporasy Intemet Fes K8 ||
L || | [F] | i Chkdisk flex S5.052KB
[#] # Recycls Bin oK
[4] ] Setup Log Fies TIBKE o
Total amourt of disk space you gainc 6B6.7T0KR
Diescnplion S
mmmm“wmwmm
downloaded sutomatically from the Intemat when you view cerlain
mﬂbnmm-dhhwm
foldes on pour hard disk.
oK #[ Cancel
Fi .3h Disk Ci Di
= Click OK. ig. 2.1.3 _"f'f_ ialogue Window |

=% |t deletes all the unnecessary files from the drive.

- [}
2.2 Application Software
Application software is a set of computer programs that enables/helps users to do
a specific work on the computer Application software helps a user to produce
documents, create graphics, perform calculations, play games, compose music, play
movies and so on. There are vast varieties of application software. Some of them are
discussed below.

2.2.1 Entertainment Software

Entertainment software are developed to entertain users. Computer games are the
most popular type of entertainment software. A user can play cricket, fly a jet, battle
with monsters, run favourite music and videos while using these software.

Windows Media Player; Real Player, EA Sports, Need For Speed etc are some examples
of entertainment software.
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Mavie player Media player
Fig. 2.2.1 Entertainment Software

2.2.2 Productivity Software

Productivity software helps users to work more effectively and efficiently to solve
their problems. Some of the popular types of productivity software are given below.

Word processing software are used to
produce documents such as letters,
reports, papers and memos. M5 Word,

WordPrefect and Motepad are some ~ Wi
s —= [WFFICE %4

examples of Word processing software.

Spreadsheet software are used to work
with numbers and formulae. A user enter
numbers in the grid of rows and columns
on the spreadsheet and computer
performs the calculations. MS Excel, Lotus
I-2-3 and Corel's Quattro Pro are some ! ),_,/—J

examples of Spreadsheet software. Fig. 2.2.2a Word Processing and Spreadsheet Software
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Graphics software are used to draw
pictures, 3D images, and animations.
MS Paint and Adobe Photoshop are
some examples of Graphic software.

Multimedia Software are used to create
visual presentations. A user can also insert
audio and video clips in his/her
presentation. MS PowerPoint and Adobe
Flash are some examples of Multimedia
software.

Fig. 2.2 Graphics and Multimedia Saftware

2.2.3 Educational and Reference
Software

Educational software help a user to
learn a particular skill. These software
are used for help and guidance in
different subjects such as Mathematics,
English, Science, Arabic, etc.

Reference software provide information
on a multitude of topics. Such software
contain large amounts of data and its
examples include dictionaries,
encyclopedias, maps software, etc.

Fig. 2.1.3b Reference Software
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Exam Preparation software are also I % Academic (=)
available for standardized tests such as :

CacEva
SAT. GMAT. GRE, etc. : .

Moreover typing tutor helps to improve
the typing skills.

Fig. 2.2.3c Exam Preparation Software

Summary
Software Is the set of instructions given to the computer to perform a specific task.
System Software are used to control and direct the operations of a computer hardware.

Operating System |s a system software. It is just like the soul of a computer ltis a
collection of programs that supervises and controls overall functions of a computer.

A Device Driver tells the operating system how to communicate with a device.

Utility Program allows a user to analyze, configure and maintain the computer.

File Management Utllity helps user to manage a stored file on the hard disk.

Image Viewer provides an environment to view and manage images within the same folder.
Disk Scanner utility Is used to detect physical and logical problems of a disk.

Application Software is a set of computer programs that enables/helps auserto do a
specific work on the computer.

Entertainment Software are developed to entertain the users,
Educational Software helps a user to learn a particular skill.
Reference Software provides a collection of information on any topic.

Productivity Software helps the users to work more effectively and efficiently to solve
thelr problems.

Word Processing Software are used to produce documents such as letters, reports,
papers and memos etc.

Spreadsheet software are used to work with numbers and formulae.
© Graphic Software are used to draw pictures, 3D images and animations,

Multimedia Software are used to create visual presentations. A user can also insert
audio and video clips in his/her presentation,
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Software Basics

Q.| Tick the correct choice.

) is the set of instructions given to the computer to perform a
specific task.
a) Monitor b) Hardware ¢) Software d) Printer

i) creates a link between a user and the computer.
a) Device Driver  b) Utilitles ) Operating System  d) image Viewer

iii) is the most famous type of Operating System for personal
computer. -
a) Linux b) Unix ©) Microsoft Windows  d) Mac OS

iv) A system software that helps Operating System to communicate with a device is
called

a) Operating System b) Device Driver ©) Utility d) Graphics software
V) is a program that allows a user to analyze and maintain a computer.
a) Uity b) Device Drivers £) Windows XP ) MS Office

vi) Windows explorer serves as a

a) System Manager b) File Manager ¢) Web Browser d) Device Manager
vi) is a utility program that provides a facility to view and manage images.
a) Image Viewer  b) Text Viewer ¢) System Viewer d) File Viewer

viii) Disk scanner in Windows is known as

a) Disk Cleanout ~ b) Disk Cleanup ) Disk Cleaning d) Disk Defragmenter

ix) A computer software that helps users to do a specific task on a computer is known
e .

a) System Software b) MS Office Software
©) Anti-virus Software d) Application Software
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Software Basics

x) software are used to learn a particular skill.
a) Graphics b) Multimedia ) Educational d) Reference
xi) Computer game is an example of software.
a) Entertainment b) Exam preparation ¢) Reference d) System
xii) Encyclopedia is an example of software,
a) Entertainment  b) Educational c) Productivity d) Reference
Xiii) is a world renowned composing software.
aMs PowerPoint  b) MS Word o) Typing Tutor d) Adobe Photoshop
Xiv) software are used to create visual presentations.
a) Graphics b) Mulimedia ¢) MS Paint d) MS Excel
xv) When a computer starts, operating system checks all the and
loads their drivers so a user can work properly.
a) Programs b) Devices c) Drivers d) Network
Q.2 Define the following.
i) Software ii) Utility Program fif) File Manager
vi) Disk Scanner v) Device Drivers

Q.3 Differentiate between the following.
1) File Manager and Image Viewer

i) Application Software and System Software

iii) Entertainment Software and Educational Software

iv) Word Processing and Spreadsheet

v) Device drivers and Utilities

Q.4 Give brief answers to the following questions.

i) What is an operating system?
ii) List the names of any five Application software,
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Software Basics
fii) What are the Utility Programs?
iv) Write down basic operations of the Operating System.
v) Can a device work without Device Driver?
vi) Wrrite down the names of Windows Image Viewer and its working
vii) How can a user delete unnecessary files from the computer?
viii) List any three Productivity Software.
ix) Write the steps to use Disk Cleanup utility in Windows.
x) Write down any two uses of the following software.
a) Word Processing b) Spreadsheet

c) Graphics d) Multimedia
Q.5 Match column A with column B and write the matching pairs number in
column C.

ii) Graphics software b) Typing Tutor
iii) Entertainment software ©) Windows 7
iv) Educational software d) MS Paint
v) Word processing software e) Real Player
vi) Operating system f) Wikipedia
vii) Spreadsheet software ) PowerPoint
viil) Multimedia software h) Disk Cleanup
ix) Utility Program i) MS Excel
x) System Software ) Device Driver
I k) Manages file/folder
[) Configuring Devices
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Software Basics

Follow the steps to view the Devices Installed on your computer.
=% On the desktop, Right Click on My Computer and select Properties.

= System properties window opens.

Garms Mo | My | dveecsd |
=% Click Hardware s S
oy bl g
R TR
=% Click Device Manager | )
Comsmy
| Cinrvme L. wam P inmtalier] iy e
T
i S et
| ‘ H-ﬁ-&--h—hﬂ.ﬂﬁl
| o
=% Device Manager window |- —
T
appears.
I ===
i . z e
B oS ] =
ﬁ‘m
- (=N
4 ugn Disk drives
mam-ﬁm
* i Foppy dek controllers
- Fopoy dek drives
E IDE ATAJATAPI conirolersy
: > m Now see, all the devices are properly
#% T7) Mon ardl other porning devica: wstalled axcept
* 5 Meniors yedlow k“'.'“?_ gation mark.
S e It means the driver of the Modem is
= f Ports {COMBLPT) not installed properly.
- itk | .
£ Sgurd, wideo and gama
I Syshem devices
- Universal Serial Bus controllars

Lab Activity ( Recognizing Utility Programs )

Write the names of different utility programs in Windows operating system.
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Aj‘ter completing this unit, students will be able to:

change the view of a document.
& increase/decrease zoom settings.
split a document Inte sections.
& Insert/delete text in the document
® move or copy text to.a new location.
' undo/redo last edited changes in the
document.
& insert current date and time In a
document.
3 count the number of words in a document.
' find and replace a word or phrase in @
document.
@ use thesaurus,
insert symbols and add a comment to text
in the document
@ change Font, Style and Color of the text.
@ highlight text In the document.
change alignment and line spacing of the
fext.

create a bulleted or numbered list.

indent text in-a paragraph.

use tabs to line up Information in a
document

add border and shading to text in the
document,

insert a page break and section breaks

in the document.

add page numbers, header and footer in
the document.

add footnotes or endnotes in the document
change the margins in the document
center vertically, the text on a page.

change the orientation of pgge

add a water mark in tidoen

create newspaper colli

preview a document G|
use different print opti
document.

change paper size an
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Introduction to Word 2007

Word 2007 is one of the most popular Word processing software in the market.
It is used to produce a variety of good-looking documents such as letters,
reports, messages, notes and other documents,

ataceon] aadoccse hﬂhﬁ*ﬁ -!-'.

_ Change
- - i -

Vertical Ruler Status Bar Views Zoom Slider  Scroll Bar
Fig. 3a Word User Interface

Office Button @

Office Button is at the top-left corner of the Word window. It provides fast
access to files and frequently used commands such as create a new
document, open an existing document, save a document, print a document
or close a document etc.

Quick Access Toolbar @@ -

Quick Access Toolbar is located next to the office button. It holds the
commands like save, undo, redo, etc. which are used frequently.
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The Ribbon is the panel below the Titlé Bar. It presents commands organized
into a set of tabs called Ribbon Tabs.

M

*-m l-inl h-] R,

-. nesvcety | ASBO) 4\ I"“
- .".
| thgmsl | THoSpac  Mesdiag] o Chamge .m;
d:h She= | =
2 1 'Il v '.‘. -m - |
=/,

Fig. 3b Ribbon
The Ribbon is divided into seven tabs and each tab is a collection of several
groups that shows related items together.

/ 'wmw ...u‘l

& Tabis a collection of several groups of related commands.
& Groups show similar commands together.
& Dialogue Box Launcher gives access to additional commands via a dialogue

box.
& Command Buttons are used to issue commands or to access menus and

dialogue boxes.

3.1 Changing Display of a Document
Word allows a user to view a document in one of the five views: Print Layout,
Draft, Outline, Full Screen Reading and Web Layout.

Print Layout View

The print layout view is used when a
user wants to see how the document
will appear on a printed page. This is
the best way to see the work.

Fig. 3.1a n-inﬂ.ayan
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|

Fig. 3.1b Draft View

The draft view simplifies the page layout
so a user can quickly type and edit the
document. This view does not display

top or bottom margins, headers, footers
and page numbers.

EJE T P N
| @ Fmnah b e ewader of Fabintan.
i Mo burs an Drember 34, D00

o bararis, His fafher 'y num wae

Fig. 3.1¢ Outline View

The outline view is used when a user
wants to review and work with the
structure of a long document.

Full Screen Reading View

Hi w1 barw oi Detomber B5, 1IN

ik hatais (e fql.:"! TR )
Foania linnah.,

Fig. 3.1d Full Screen Reading View

The full screen reading view is used when

a user is reading a document on the screen.
This view hides all other screen elements
to make it easy to read on the screen.

Web Layout View

Hanah bs the Teapdes ol Pklaton.
b wan s i Doy 15, (W%

O [ e |

Fig. 3.1e Web Layout View

The web layout view is used when a user
is creating a web page.

Changing the View of a Document

=% Open a blank document.

=& Type your name, class, roll number and school's name as follows.
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Namz Nadeewm Ahmed
Class  Tik B,

Rell¥ 1S

Sehool Gavi, Inlamis Wigh
Rekool, Gajrat,

Fig. 3.1If Print Layout View
=& On the status bar, click one of the view buttons to change the view of the
document.

Print Layout View |_1_..‘_| Web Layout View H Cutline View
E8 Droft View |®| Full Screen Reading View

3.1.1 Zoom in/Zoom out of a Document

A user can zoom in to get a close-up view of a document or zoom out to see
more of the page at a reduced size. There are two ways to do this.

@ Quickly zoom in or zoom out of a document Zoomin

= On the Status bar,
click the Zoom slider:

@ Choose a particular zoom setting

=% On the View tab, in the Zoom group,
click Zoom 100%.
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Zoom in and out of a Document
=% Open a blank document.

=% Type your name, class, roll number and school's name as follows.
=% |n the View tab, on the Zoom group, click 100% page command.
The user can edit the document as desired.

Nadeem Ahmed

7th B,

15

Govt. Islamia High
School, Gujrat

Fig. 3.1.1a Zoom in of a document
=% Zoom outby dmging the zoom slider to 33%.

Tik B,
15
Schael Gavi. llumis High

Sehasl, Gajral.

Fig. 3.1.1b Zoom of @ document
=% To return to the normal zoom setting, drag the zoom slider to 100%.
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] =
ment into Sections
It is easy to split a document into separate sections. Each section of a split

document contains a copy of the entire document. In this way a user can
display different areas of a long document at the same time.

Splitting a Document

=% Open a saved document.

=% On the View tab, in the Window group,
click Split. L o

éu.a.uamg.m

Mouse changes to ==
Click the mouse == down to the place where we want to split the document.
The document splits into two sections.

433

MNow select the Zoom setting to 100% in both sections.
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'l On the Insert tab, the galleries include items that are
-| designed to coordinate with the overall look of your Divlding line

Vi [0 ' ' ® a1 v v i [0 W D

-| Boththe Themes gallcry and the chk Styles gallterjfr
‘| provide reset commands so that you can always
| restore the look of your document to the original
«| contained in your current template. -

. - End:_ﬂf'tl_'l'epage

W e S bt w0

Fig. 3.1.2b Split Document with 100% Zoom Setting

=% If we no longer want to split the document, just double-click the dividing line
to remove the dividing line from the document.

3.2 Editing Text

Adding, removing and re-arranging text in a document is called text editing. A user
should always select the text before performing any operation on it.

3.2.1 Inserting and Deleting Text

Adding new text in a document is called inserting text When a user inserts new text,
the existing text moves to make room for the new text.

Remaoving text from the document is called deleting. A user can easily delete a

character, a word or a block of text in Microsoft Word. When text Is deleted, the
remaining text moves to fill the empty space.

@ To delete a single character;
click to the right of the character and then press the ||_==__|| key

@ 7o delete @ word or a block of text,

select the text and then press the |
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Inserting and Deleting Text

=% Open a blank document. Pﬁyauw;awj;tmn
= Type the following sentence. | m#@ m !

=% Place the cursor after letter ‘a *.I

Fig. 3.2.1a Placing the Cursor
Press Spacebar to give space.

e
g

Amina has a beautiful car.

~
A T S e o —

Fig. 3.2.1b Inserting a New Word
=5 The word ‘beautiful’ will be inserted in the sentence.
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EditingText L S Sl bS s
=% Now select the word ‘car’.

Fig. 3.2.1c Deleting a Word

Amina has a beautiful doll.

: Fig. 3.2.1d Inserting a Word
3.2.2 Moving Text

Word provides two ways to move text from one place to the other.
© Drag and Drop

® Cut and Paste
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Dragging and Dropping Text
With drag and drop, a user selects the text and drags it to a new location and
then releases the mouse button.

Order of Eventis
=5 Open a blank document.

w9 List what you did yesterday.

D P

o "
B i e

Fig, 3.2.2a Listof Events
Select what you did first.

Drag it to the appropriate place.
Repeat until the list is ordered correctly.

‘43

Fig. 3.2.2b Ordered List of Events
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Editing Text

Cutting and Pastmg Text
Cut means to remove text from the document and place it on the office clipboard.
Paste means to transfer a copy of the text from the clipboard in the dﬂcument at the

insertion point.
_ﬁl Clipboard is a temporary area in ;
@b Select the text and click the cut 28] button ~  the computer's memory for
or press Ctrl + X on the keyboard. storing text and graphics that a

user wants to reuse. It stor
(2 Move the cursor where the text to be placed ta 24 items at 2 time.

sup

and click the paste ,@ button or press Ctrl + V on the keyboard.

Arranging Names

=) Type four names of your friends.

Zahid Khan
Fawad Ahmed
Shahzad Nadeem

Fj.z.lc o
=& Cut and paste their names so that your best friend's name Is at the top.

R [ —— Y it
" R

Fig. 3.2.2d Ordered List of Friends
= Now cut and paste their names into reverse order,
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Editing Text

3.2.3 Copying and Pasting Text

Copy and Paste means to repeat information in the document without retyping it.
When a user copies and pastes text, the text appears in both the original and new
locations.

(B Select the text and click the mpyﬂ button or press Ctrl + C on the keyboard.

@ Move the cursor where text to be placed and click the paste E button or
press Ctrl + V on the keyboard.
Birthday Poem
=h Type the following text.
Happy Birthday to you

= Copy and paste it four times.

= Make changes in the third line as requirad.

l,-lh 1II—'|'|- v 2 = - -

. - '
- & | o R El 7| ST —'IBKFIT""'- - i ] B 1

ks ) e

Happy Birthday to you
Happy Birthday to you
Happy Birthday dear friend
Happy Birthday to you

Fig. 3.2.3 Copying and Pasting Text

3.2.4 Undo/Redo Changes

Undo feature is used to discard last changes which were made in the document. If
a user makes a mistake, click on the Undotf,i button on the Quick Access Toolbar
or press Ctrl + Z on the keyboard. '

Redo feature is used to reverse the undo action. If a user performs an undo
action, then he/she can Redo It by clicking the Redo m button on the Quick
Access Toolbar or press Ctrl + Y on the keyboard.
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Unit-3 |

Toolbar, if Undo or Redo
Undo and Redo Actions e |
=  Open a blank document, <o

=& Type four names of your friends.

Fig. 1.2.4a List of Friends

=% Click Undo ‘ﬂ button on the Quick Access Toolbar or press Ctrl + Z .
This will discard the mistake and deleted name will reappear in the list.

=% Click Redo button on the Quick Access Toolbar or press Ctrl + Y.
This will reverse the undo action and name will be disappeared from the list.
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3.2.5 lnsert Current Date and T’me

A user can insert current date and time into a document. Word can
automatically update the date and time each time we open or take print of the
document.

Using Date and Time Feature

=% Open a saved document.
= Set the zoom setting to 100%.
=% Click the place where the date and time should appear in the -::Iocument.|

On the insart 1ab, the galleries include Berms that ane designed to coordnate with the overall lock
of your document. You can uss these gabaries fo inser labins, headers, foolars, lists, cover
pages, and ather document buiding blocks. When you create pictures, charts, or diagrams, they
im0 coondnmin with your cisment document lnok.

e~ —— L
Fig. 3.2.5a Inserfing Current Date and ﬂm:

=5 On the Insert Tab, in the Text group click Date and Time.

=% The Date and Time dialogue box will appears.
=& Click the Date and Time

format. bl formals:

Turn this option on B4 .
This optlon allows Word
to automatically update
the date and time each
time we open or print L ] ettty

| the document. e J[e=d ]
Fig. 3.2.5b Date and Time Dialogue box

=% (Click OK to confirm the selections.
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Qn the Insar tab, the galieres includa ilems that are designed 1o cocrdingbe with the overall
Iock of your document. You can use thess galleries to insar tables, headars, fooberns, lisis,
covar pages, and other document bullding blocks, When you creats piclunas, chars, or

Fig. 3.2.5¢ Inserting Current Date and Time

3.2.6 Count Words in a Document

When a user types in a document, Word 2007 automatically counts the number of
pages and words in the document and displays them on the status bar at the bottom

Word Count Tool

ey rodesty o S s 3. Wy
ook T e o g flr
S i T S g o

sl aBw sdn 3

S L L i
Fig. 3.2.6a Count Words in a Document
Word also counts the number of pages, characters, paragraphs and lines in the document.

Counting Words
=9 Open a saved document.

=% Set the Zoom setting to 100%.
=& On the Review tab, in the Proofing group, click Word Count. *
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The Word Count dialogue box appears.

This dialogue box displays the total :
number of pages, words, characters, | Pages

I
hs and i thed i e
s and lines in the document. | Characters (no spaces) 316
paragrap Characters (with spaces) 475
Parscy aphs 3
Unes 6
Click Close button to close the — (7] Inchude textbases, fotnobes and endnotes
Word Count dialogue baox. | i E

3.2.7 Find Text ‘ Fig. 3.2.6b Word count dialogue box

When a user works with a longer document, the quickest and the easiest way to find a
particular word or phrase is to use the Find command.

Finding Text

Type the following paragraph and save it as Jinnah.dooc

e R (D5 . rosoft Wi

On his return to India Jinnah joined the Indian National Congress. Jinnah wanted 1o see

India a free country but he found that the Congress wanted Hindu Raj in India. He then
left the Congress and joined Muslim League. He demanded a separate state for Muslims,
On August 14, 1947, Pakistan appeared on the map of the world. When Pakistan came
into being Jinnah became its first Governor General. He died in Karachi on September
11, 1948,

Fig. 3.2.7a Finding text
On the Home Tab, in the Editing group, click Find or press Ctrl +F

Find and Replace (IS )

dialogue box appears, 1| ™ |feges | oo | Eo den it = =5
Pod bt — rwsh . > Ll
In the F
Find what box, .
Type ' Jinnah ', | ] :
(> ] (-] (e ]
Click Find Next to start the search. Fig. 3.2.7b Find and Replace dialogue box
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o= Lot e

=% Word highlights the first matching word it finds,

ok
On his return to India Jinnah joined the Indian National Congress, Jinnah wanted to see India
a free country but he found that the Congress wanted Hindu Raj in India. He then left the
Congress and joined Muslim League. He demanded a separate state for Muslims. On August
14, 1947, Pakistan appeared on the map of the world. When Pakistan came into being Jinnah
became its first Governor General. He died in Karachi on September 11, 1948,
Fig. 3.2.7¢ Finding text

next matching word. L= E':':k :

=% Repeat until a dialogue box appears, telling that search is complete.
=% Click No to close the dialogue box. |

3.2.8 Find and Replace Text

Replace command is used when a user wants to replace a word or phrase with
some other word or phrase. This feature can be used to make several changes
with a single click.

Replacing Text
Retrieve the document Jinnah.docx.
=% On the Home Tab, in the Editing group click Replace.

On his return to India Jinnah joined the Indian National Congress. Jinnah wanted to see India
a free country but he found that the Congress wanted Hindu Raj in India. He then left the
Congress and joined Muslim League. He demanded a separate state for Muslims. On August
14, 1947, Pakistan appeared on the map of the world. When Pakistan came into being Jinnah
became its first Governor General. He died in Karachi on September 11, 1948,

T .

Fig. 3.2.8a Replace text
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-_I» Find and Replace dialogue box appears.

=% Inthe | Frg | gl | Goto |
Find what box, Frdwhat: - [3rrah -
Type ' Jinnah ". r
((eiecs | [Repice sy | [primen ] [ o ]
Fig, 3.2.8b Find and Replace
dialogue box

=% In the Replace with box, Type ' Quaid-e-Azam ‘

=% Click Replace All. M
This will replace the word ‘Jinnah’ with *Quaid-e-Azam’ in the whole document.

=% Click OK to close the message. e P AR
riﬁ_ . — Replaced te

On his return to India Quaid-¢- joined the Indian Mational Congress. Quaid-e-

wanted to see India a free country but he found that the Congress wanted Raj in
India. He then left the Congress and joined Muslim League. He demanded a separate
state for Muslims. On August 14. IEMT. Pakistan appeared on the map of the world, When
Pakistan came into being became its first Governor General. He died in

Kmuluunﬂeptanhctll 1948,

Fig. 3.2.8¢ Repi'ﬂmfw

3.2.9 Using the Thesaurus

Thesaurus suggests other words with a similar meaning to the selected word. Using
the Research task pane, a user can look up synonyms (different words with the same
meaning) and antonyms (words with the opposite meaning) in the thesaurus.

Using the Thesaurus
Retrieve the document Jinnah.doox
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refum to India Jinnah joined the Indian National Congress. Jinnah wanted to see
India a free country but he found that the Congress wanted Hindu Raj in India. He then
left the Congress and joined Muslim League. He demanded a separate state for Muslims.
On August 14, 1947, Pakistan appeared on the map of the world. When Pakistan came
into being Jinnah became its first Governor General. He died in Karachi on September
11, 1948,

Fig. 3.2.9a Using Thesaurus
=% On the Review tab, in the Proofing group, click the Thesaurus.|

=% The Research task pane appears. [ cﬂtkﬂtdﬁnd
=% The selected word '

appears here. —_ Neean

=% Click Thesaurus. B | '

 displayalist of
resources we

 can use to search

=P Position the mouse
over the word we
want to use in the
document, ——

=

=% Click the arrow (I8 )
beside the word we
want to use.

~ inboldinthisareahasa
iL -ward'-?n'.tﬁedmgnt;

|
Try ane o these sbpmatos o ame e - word offers a synonym
=P Click Insert to s ety " for the bold word.
Saarse i ewten o NI SO R

replace the word
in the document
with the new word. Fig. 3.2.9b Research task pane
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Omn his.arrival to India Jinnah joined the Indian National Congress. Jinnah wanted to see
India a free country but he found that the Congress wanted Hindu Raj in India, He then
left the Congress and joined Muslim League. He demanded a separate state for Muslims.
On August 14, 1947, Pakistan appeared on the map of the world. When Pakistan came
into being Jinnah became its first Governor General. He died in Karachi on September
11, 1948, 3

Fig. 3.2.9¢c Using Thesaurus

3.2. 10 lnserﬁng Symbols

A user can insert symbols in the document such as copyright symbols, trademark
symbols, paragraph marks, etc. which are not on the keyboard.

Inserting Symbol

= Open a blank document.
-} T}rpe the fo1|mu1ngtﬂi¢.

568, Johar Town, Lahore
(Phone)042-37895602, 37628945

m} Crick symbnfs in the Insert tab.. N
Most recently used symbols appear in a box.
= If required symbol is not there then click More Symbols
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5 |
the visiting card. J | #ixedaid@ s FloBEsiest
! RE[§ 52 & 2helm=R|E|6
OO ENEEEEEAR
RN CEECDEREE OGRS
= Click Insert. (Sl vle]*[=[2[x[s[2[+[x|=[u]a]
| Wrgingu « Craracee sad 40 | o Sy gy 9
| sancomes... | | Sorc oy |
Cr=flo=|
=% Selected symbol will be Fig. 3.2.10b Symbol dialogue box

E‘:E, Johar Town, Lahore
:!): 042-37895602, 37628945

....

TS -

Fig. 3.2.10c Inserting Symbol

3.2.11 Adding a Comment

A comment about a selected text can be added in the document. A comment can
be a note, explanation or reminder that a user adds to a document.

Word displays the comment in a balloon in the margin of the document or in the

Reviewing Pane.
Adding a Comment

Open the document [innah.docx
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= Select the Web Layout View or Print Layout View.
wi Select the text we want to add a comment to. For example *Jinnah”.

On his return to India Jinnah joined the Indian National Congress. Jinnah wanted to see
India a free country but he found that the Congress wanted Hindu Raj in India. He then
left the Congress and joined Muslim League. He demanded a separate state for Muslims.
On August 14, 1947, Pakistan appeared on the map of the world. When Pakistan came
into being Jinnah became its first Governor General. He died in Karachi on September
11, 1948,

FE il?luAduﬂhga comment

=% In the Review Tab, Click New Comment |
in the Comments group.

=& A Comment balloon appears in the right margln of the document.

Cuugrmiinmhwm@dtﬁmluﬂilaﬁﬂmmhn
he found that the Congress wanted Hindu Raj in India.
He then left the Congress and joined Muslim League.
He demanded a separate state for Muslims. On August
14, 1947, Pakistan appeared on the map of the world,
When Pakistan came into being Jinnah became its first
Governor General, He died in Karachi on Septemb

Fig. 3.2.11b Adding a comment

=5 Type the comment.
wi  After typing the comment, click outside the comment balloon.

Not For Sale - PESRP (58 =



 Editing Text

Deleting a Comment
A user can delete the comment and remove the colour highlight and brackets from
the text in the document.

=% Click the comment balloon containing the comment.

=% In the Review Tab, in the Comments group, click Delete Comment button.

3.3 Formatting Text

Formatting text can enhance the appearance of the document. A user can use
various fonts, styles and colours to emphasize important text. A user can also adjust
the spacing between lines of text and change the alignment of text.

3.3.1 Fonis

A fontis a set of characters (i.e letters, numbers and symbols) with a specific
design. Fonts are used to enhance the appearance of the document. Fonts
have names such as Time New Roman, Arial, Verdana, etc.

Methods to Change Fonts

There are three methods of changing fonts.

(i) Changing Fonts using Ribbon
=& Open a new blank document.

=% Type your name and school's name as follows.

B L b e SRl 2

Fig. 3.3.1a Changing fonts using Ribbon

= Select the text.
=% On the Home Tab, in the Font group, click here to see a list of fonts, —
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. Formatting Text
=% A drop-down list of fonts appears.

=% Choose a new font.

P
=H Font of your name and school's name will be changed. | fiaeaAx

Shazia Jamal
Govt. Islamia Girls High School, Gujranwala.

"~ Fig. 3.3.1b Changing fonts using Ribbon
(i) Changing Fonts using Mini Toolbar
= Open a new blank document.

=4 Type your name and school's name as follows.

Calibri =11 "ff&v#
e |B L WA R

wh Select the text. Fig. 3.3.1c Changing fonts using mini toolbar

=& The Mini Toolbar appears automatically.
=& Move the pointer to Mini Toolbar above the selection and click here.
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Farm._atting Text ,
=& A drop-down list of fonts appears. S

&« A7)

S— =
=% Choose anewfont. | % Baskerwhe-DemiBold

=% Font of your name and school's name * Baskerdlle-Medium
will be changed.

Shazia Jamal
Govt. Islamia Girls High School, Gujranwala.

Fig. 3.3.1d caunginx uﬂug mm

(iii) Changing Fonts using Font Dialogue Box
=% Open a new blank document.
* ‘I?peyuurname and xhaalsnameasfnllm

TP T PP P PP S AT e pr—
L%

wb Select the m’ Fig. 3.3.Ie Changing fonts using fond diclogue box

=& On the Home Tab, click Font dialogue box launcher.
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Fogt

Ch | Eoadar
=i oose a new fon L..*%

= Click OK fimes

This s & TruaTyps Fenk. This font wil be used on bath printer nd scresn,

=5 Font of your name and o ][ cnn |
school's name will be changed! Fig. 3.3.1f Font dialogue box

D0k * Doamems - Mirosoftword

Shazia Jamal
Govt. Islamia Girls High School, Gujranwala.

Fo—o————

. L

Fig. 3.3.1g Changing fonts using font dialogue box

. o
e s o, Bty ot [ ot e,

3.3.2 Font Style

To emphasize information in the document, a user can make the text bold, italic or
underlined. These formatting commands can be activated easily by clicking any of
these buttons B ] 1 respectively.
mmw E | s i % - z T . & 3
e | e B
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- Formatting Text.

Changing Font Styles
Do you remember last match between Pakistan and India.
= T;-rpe the fﬂllmﬂng text.

Pakistan Vs India
Pakistan won by 64 runs. Abdul Rﬂzzaq is awarded
as man of the match for his unbeaten 85 runs in 50 balls.

3.3.2a Ch
Sl T RO

On the Home Tab, in Font group, click this B button or press Ctrl + Bto
make it bold and uj underlined or press Ctrl + U,

Paki Vs Indi
In next line, select the word PakRistan” and make it bold too.

-
= Select all the figures like é4, 85 and 50 make them italic or press Ctrl + 1.
-5

Select the name “Abdul Razzaq" and make it bold and italic.

Pakistan Vs India
Pakistan won by 64 runs. Abdul Razzag is awarded
as man of the match for his unbeaten 85 runs in 50 balls.

Fig. 3.3.2b Changing font style.
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Formatting Text

3.3.3 Text Colour

A user can change the colour of text to make the document more attractive and
beautiful.

Changing Text Colour

= Open previous file.
=& Colour it as given below.

Pakistan Vs India
Pakistan won by 64 runs. Abdu/ Razzagq is awarded
as man of the match for his unbeaten 85 runs in 50 balls.

e e R
-

ms.s.hﬂm;mm. =

=& |t can be done by selecting a word .lautﬂmt“
and clicking here, e Theme:
DIE}.IIIIII

on the Home Tab and in Font group.
w A list of colours appears : illlililii

= Select the required colour.

..Il?:_!-..l--
% | More Colors...

Fig. 3.3.3b Theme colors

3.3.4 Highlight Text

Highlighting tool is used to mark and find important text in the document.

Highlighting the Important Text

Retrieve the document Jinnah.doox

Not For Sale -PESRP 65



Dn lns return to India Jinnah _]Dltlﬂd the Indian National Congress. Jinnah wanted to sce
India a free country but he found that the Congress wanted Hindu Raj in India. He then
left the Congress and joined Muslim League. He demanded a separate state for Muslims.
On August 14, 1947, Pakistan appeared on the map of the world. When Pakistan came
into being Jinnah became its first Governor General. He died in Karachi on September
11, 1948,

a3 - = Fig. 3.3.4a Highlight the text
= On the Home Tab, in Font group, |

click this button sy o |

to display available highlight colours. | S
Click highlight colour we want to use. | E = = = =
EEE B
ﬁ| H’H ﬂﬂlhr

| Itun rummm
The selected text appears highlighted. Fig. 3.3.4b Available
highlight colours
After finishing highlight text, click this [g button again or press Esc.

The mouse I changes to.4 when It is over the document.

=
=5
= Select each area of text by dragging the mouse.
=
i

On his return to India Jinnah joined the Indian National Congress. Jinnah wanted to see

India a free country but he found that the Congress wanted Hindu Raj in India. He then
Iefnhef.‘ougrm and joined Muslim League. He demanded a separate state for Muslims.
947, Pakistan appeared on the map of the world. When Pakistan came
became its first Governor General, He died in Karachi on -

=% To remove a highlight select ‘No colour’. Fig. 3.3.4c Highlight the text
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Fnrmattmg Text B T 2 3

3.3.5 Allgnment of Text

Alignment is the way in which text is placed between margins of the page. Text can be
lined up at the left, center or right side of the page.

LeftAlign ] Center E|
Aligns text at the left margin. This is The text is centralized on a line, It
the default setting. Left alignment of can be used in a card, on an envelope
text is found in most documents. and in a listing.
Right Align  =| Full Justification |
Aligns text at the right margin. This The text is justified on both sides.
can be used for addresses. It can be seen in books, newspapers,
magazines and reports.
Alignment of Text
= Type a short poem. ———— Align icons
! 3 - B
NSl |
Cobbler, Cobbler, mend my shoe, Left Align
Get it done by half past two; cgnterAlT.tgn
Stitch it up, and stitch it down, Right ,qﬁ?n
Then I'll give you half a crown. jusuﬁf-
Fig. 3.15At{gnmmaf rext

=% Hold ‘E and press A to select it all,
=% On the Home Tab, in the Paragraph group,

click each Align icon _;_l !l _ﬂ;] !I one by one to get new alignment.
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_ Formatting Text

3.3.6 Change Line Spacing

Line spacing determines the amount of vertical space between lines of the text in a
paragraph. By default, lines are single-spaced.

Changing Line Spacing

Retrieve the document Jinnah.doox P ——

On his return to India Jinnah joined the Indian National Congress. Jinnah wanted to see §

India a free country but he found that the Congress wanted Hindu Raj in India. He then
left the Congress and joined Muslim League. He demanded a separate state for Muslims.
On August 14, 1947, Pakistan appeared on the map of the world. When Pakistan came
into being Jinnah became its first Governor General. He died in Karachi on September
11, 1948,

Hold and press A to select it all.

On the Home Tab,
in the Paragraph group,

click Line Spacing button [ ="
to display the available Line Spacing options. ﬁ =
1
W [1as
=% Click the required Line Spacing option. 18
0
=& Click each Line Spacing option one by one to |

(130

see new layouts. Lint Spacing Options...
fE | AodSpace Before Paragraph
f Remove Space After Paragraph

Fig. 3.3.6b Line spacing options

WES) Not For Sale - PESRP



Furmattmg Paragraphs.

3.4 Fonnattmg Paragraphs

A user can organize ideas and add structure to a document by creating a bulleted or
numbered lists. A user can increase or decrease the indentation of a paragraph or
group of paragraphs. Borders can also be used in the document to draw attention to
important information.

3.4.1 Bulleted or Numbered List

To organize text and make it easy to read, a user can use numbers and bullets.
A bullet is a small symbol such as a circle or square etc. that marks an important
line of information ( list ).

When someone wants to show items in a sequence, numbers are used to mark lists.

Adding Bullets ( A Shopping List )
=% Open a new blank document.
= Type the following shopping list

Fig. 3.4.1a Adding bullets

= Select this shopping list except heading.

=% On the Home Tab, in the Paragraph group,
click thisbuttontoaddballets. - _ Lt

*
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= The bullets dlal‘ague box appears.

=% Click the style we want to use.

= Click OK to confirm the selection.

=& To remove bullets ﬁ'nm a list, select None. Fig. 3.4.1c Adding bullets

A Number List ( Sandwich Recipe )
=& Type the following recipe.

Get some bread,
Cut it into slices.
- Spread some butter,
Place some slices of tomatoes,
Spread small pieces of chicken.

=& Select this recipe except heading. Fig. 3.4.1d Adding number fist
=% On the Home Tab, in the Paragraph group, click this button to add numbers.
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=% Click the style we wantto use,

=% Click OK to confirm the selection.

Flg. 34T Nusber
dialogue box

Get some bread,

Cut it into slices.

Spread some butter.

Place some slices of tomatoes.
Spread small pieces of chicken.

Fig. 3.4.1f Adding number list

=5 To remove bullets from a list, select None.

You can create a bulleted or numbered list as you type.

1. Type * to create a bulleted list or type 1. to create a numbered list.
Then press the spacebar.

2. Type the first item in the list and then press H key. Word automatically
adds a bullet or number for the next item.

=% To finish the list, press the = key twice. ’
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3 4.2 lndent Paragraphs
An indent is the space between text and the margin. Indentation determines the
width of lines in the paragraph. Within the margins, a user can increase or decrease
the indentation of a paragraph or group of paragraphs. Word offers several indent
options.

First Line Indent Hanging Indent Indent Both Sides
R —— TR e
———— - ‘ - |=' a—
N e ————
Indents only first Indents all but first Indents both left
line of a paragraph. line of a paragraph. and right sides of a
paragraph.

=% A user can move these symbols g £ on the Horizontal Ruler to indent
paragraphs in a document.

L"I'I"n“.".he symbols indent the l This symbol (Q) indents
left edge of a paragraph. the right edge of a
paragraph.
=% ) First Line Indent =% () Rightindent
=i e Hanging Indent = 5 Left Indent
] To indent text with extra precision,

select one of the following on the Home Tab, In Paragraph group...
* Click Incregse Indent button, Click Decrease Indent button.
Text moves |/2 inch from the left margin. Text moves |2 Inch to the left margin.
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First Line indent

Retrieve the document finnah.dooc =
= Divide it into two paragraphs. For this press key in the beginning of fourth line.

-N"_"-I-_—K_.F_—‘: - ﬁw"m_

..1\-1 e

riapry RN R SR I O O O R RN
On his return to India Jinnah joined the Indian National Congress. Jinnah wanted to see
India a free country but he found that the Congress wanted Hindu Raj in India. He then
left the Congress and joined Muslim League.

He demanded a separate state for Muslims. On August 14, 1947, Pakistan appeared on

the map of the world. When Pakistan came into being Jinnah became its first Governor
General. He died in Karachi on September 11, 1948,

e T T T TR NN TR RS T e L e e —— 1

a
el P RS R PO I S — i ]

Click any where in the first paragraph. Fig. 3.4.2a First line indent

p

mh Move this symbol ( (J) at 1 on the horizontal ruler .
This will indent first line of the first paragraph.

=5

=5

Click any where in the second paragraph.

Move this symbol ( ) at 1 on the ruler. S
This will indent first line of the second paragraph. First i.injg Indent

On his return to India Jinnah joined the Indian National Congress. Jinnah
wanted to see India a free country but he found that the Congress wanted Hindu Raj in
India. He then left the Congress and joined Muslim League.

He demanded a separate state for Muslims. On August 14, 1947, Pakistan
appeared on the map of the world. When Pakistan came into being Jinnah became its
first Governédr General. He died in Karachi on September 11, 1948,

Fig. 3.4.2h First line indent
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Hanging Indent
Retrieve the document Jinnah.docx.
ll} Divide it into two paragraphs. For 1:h|s. press £

key in the beginning of fourth Iine
M M S, i

................................

On his return to India Jinnah joined the Indian National Congress. Jinnah wanted to see
India a free country but he found that the Congress wanted Hindu Raj in India. He then
left the Congress and joined Muslim League.

He demanded a separate state for Muslims, On August 14, 1947, Pakistan appeared on
the map of the world. When Pakistan came into being Jinnah became its first Governor
General. He died in Karachi on September 11, 1948,

Click anywhere in the first paragraph, Fig. 3.4.2c Hanging indent

g
= Move this symbol ( 9 ) at | on the horizontal To move t.hc e
ruler. This will indent first paragraph except first line. hanging indent
- drag it by using the
upper paman
=

Click any where in the second paragraph.

Maove this symbol ( 9 )} at 1 on the ruler .
This will indent second paragraph except first line.

| Haﬂgﬂg In&ent

i to India Jinnah joined the Indian National Congress. Jinnah wanted to see
India a free country but he found that the Congress wanted Hindu Raj in
India. He then left the Congress and joined Muslim League.

He demandaﬂ a separate state for Muslims, On August 14, 1947, Pakistan appeared on
:the map of the world. When Pakistan came into being Jinnah became its
first Governor General. He died in Karachi on September 11, 1948,

Figr. 3.4.2d Hanging indent
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Unit - 3

Indent Both Sides

Retrieve the document Jinnah.docx.
== Divide it into two paragraphs. For this press E key In the beginning of fourth line.
- = s s s b s _Sper—ane 1@ ||-‘=.w-i.“'- i T;.fl_l‘.-.ﬁ__u: - - = .

.

b rhosoe [l

On his return to India Jinnah joined the Indian National Congress. Jinnah wanted to see
India a free country but he found that the Congress wanted Hindu Raj in India. He then
left the Congress and joined Muslim League.

-| He demanded a separate state for Muslims, On August 14, 1947, Pakistan appeared on
.| the map of the world. When Pakistan came into being Jinnah became its first Governor
-| General. He died in Karachi on September 11, 1948,

e ¥ ST LY KT S S Y " A - s
Fig. 3.4.2¢ Indent both sides =
=% Click anywhere in the second paragraph. To move the
left indent
=& Move this symbol ( [] ) at I on the horizontal drag it by using
ruler. the rectangle

=% Move this symbol ( €O ) at 5.5 on horizontal ruler from the right side.

__ Leftindent __ RightIndent

ol e e e ]

e

On his refurn to India Jinnah joined the Indian National Congress. Jinnah wanted to sce
India a free country but he found that the Congress wanted Hindu Raj in India. He then
left the Congress and joined Muslim League. :

He demanded a separate state for Muslims. On August 14;
1947, Pakistan appeared on the map of the world. When
Pakistan came into being Jinnah became its first Governor
General, He died in Karachi on September 11, 1948,

e P

Fig. 3.4.2f Indent both sides
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Formatting Paragraphs

3.4.3 Aligning Text with Tabs

A tab is used to position text at a specific location in the document. A user should use
tabs rather than the spacebar to vertically align the text because tabs are more

accurate and faster to change.

Aligning Text with Tabs
=% Change the font size to 8.

=% Type names of your three friends and press f!:" )

=% Type three more namesandpmssrjf'-' ;

=% Continue this for three or four lines.

Amir Naeem Babar

Raheem Fawad Badar

Kamran Imran Qamar
 Jameel Zeshan Irfan

=% Click between the names and press @ to put them in columns.

—

L]
N S L T

Fig. 3.4.3 Aligning text with tabs

=% We can press two or three times if the names are long.
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Formatting Paragraphs

3.4.4 Tab Sto

A tab stop is the location where text moves when someone presses the Tab key. By
default, tab stops are located at every 1/2 "(0.5 inch) from the left margin, but a user
can modify tab stops. Word provides five tab-stop alignment styles.

Left Tab Center Tab Right Tab Decimal Tab Tab

A Left Tab AcCenterTab  ARight Tab Text aligns at Bar Tab inserts
aligns text centers text aligns text the decimal point. vertical bar at
to the left underthetab  to the right e tab stop

45.23
of the tab stop extending  of the tab 145.60 nd then aligns
stop. equal distance stop. to the right
to the left and right. 0369 the bar.

=ik

' We can quickly set tabs by clicking the tab selector at the left end of the horizontal ruler until
 itdisplays the type of tab that we want and then clicking the ruler at thelocation we want.

Setting Tab Stops

=& Type your name and school's name as follows.

Fozia Shahid
Govt. Model Girls High School, Sahiwal.

Fig. 3.4.4a Setting tab stops
wd Select the text.

=& Click the tab selector on the far left of the horizontal ruler

until the required type of tab appears. c
= Click the horizontal ruler where we want to set the tab stop.
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Fozia Shahid
Govt. Model Girls High School, Sahiwal.

Fig. 3.4.4b Sewting rab stops
=% Now one by one use all five tab-stop alignment styles.

We can also move the tab.
= Select the text that uses the tab,

=% Drag the tab to a new location on the horizontal ruler. v

=% The text moves to the new location.

Fozia Shahid
Govt. Model Girls High School, Sahiwal.

We can also remove a tab.

Position the mouse over the tab and then drag the tab towards left of the horizontal
ruler:
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Formatting Paragraphs

3.4.5 Add a Border

Borders are lines that a user can add to the top, bottom or sides of the
paragraphs. Borders are used in the document to draw attention to important

information.

Adding Borders

Retrieve the document finnah.doox . {

b thide it into two paragraph& For this press

=l in the beginning of fourth line.

On his return to India Jinnah joined the Indlan National Congress. Jinnah wanted to see

India a free country but he found that the Congress wanted Hindu Raj in India. He then
left the Congress and joined Muslim League.

He demanded a separate state for Muslims. On August 14, 1947, Pakistan appeared on
the map of the world. When Pakistan came into being Jinnah became its first Governor
Gieneral. He died in Karachi on September 11, 1948,

=8 Select the second paragraph.
=& On the Page Layout tab, in the Page Background group, click Page Borders.

Fig. 3.4.5a Adding borders

=% In the Borders and Shading dialogue box, click the Borders tab and then
click one of the border options under Settings.

Types of Border:

Click hereto ——

select a colour

for the border

shading dialague box
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On his return to India Jinnah joined the Indian National Congress. Jinnah wanted to see
India a free country but he found that the Congress wanted Hindu Raj in India. He then
_lnﬂ the Cﬂugr-.-m and Jamnd Muslim League,

He dzmanded a upmt: state f'or Musluus On August 14, 1947, Pakistan appeared on
the map of the world. When Pakistan came into being Jinnah became its first Governor
General. He died in Karachi on September 11, 1948,

Fig. 3.4.5¢ Adding borders
=& The selected text displays the border.

To Remove a Border:

=& Select the text that displays border.

ot maspuaos K]
m SelsctNone. oo e EScae) 5%
in the Border and Shading | u- ; e s e by
dialogue box. E" | 5 L
W —
=% Click OK to remove the _I“"'" - 4 B O
L — -
border to the document. | | e &
‘ CeJle)

Fig. 3.4.5d Eurdurs and shading dialogue box
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Furmamng_mragaphs

3.4.6 Add Shading

Shading is a transparent colour or pattern applied to a paragraph. Shading is used in
the document to emphasize an area of text.

Add Shading

Retrieve the document Jinnah.doox . =
"#* thde it into two paragraph& For this press [C=_|| in the b-eginnlng of fourth Ilne

On his return to India Jinnah joined the Indian National Congress. Jinnah wanted to see
India a free country but he found that the Congress wanted Hindu Raj in India. He then
left the Congress and joined Muslim League.

He demanded a separate state for Muslims. On August 14, 1947, Pakistan appeared on
the map of the world. When Pakistan came into being Jinnah became its first Governor
General. He died in Karachi on September 11, 1948,

=% Select the first paragraph. Fig. 3.4.6a Add shading
=% On the Page Layout tab, in the Page Background group, click Page Borders.
=% In the Borders and Shading dialogue box, click the Shading tab.,

F Frivviw
Click hereto——— | [mmmm— '
select a colour -.mm

for e shadeg. ' JIIIIIII _ 1| This area
displays the
Illllillil | s
. _ the selected

CrTE IIIIII ' shading.
! | More Calors.. =
I — L
o]

Fig. 3.4.6b Borders and shading dialogue box
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On his return to India Jinnah joined the Indian National Cangress. Jinnah wanted to see
lnﬂmaﬁu;myhnhefnundﬂmdummwmmnﬁmhﬂmﬂethm

He demanded a separate state for Muslims. On August 14, 1947, Pakistan appwed on
the map of the world. When Pakistan came into being Jinnah became its first Governor
General. He died in Karachi on September 11, 1948,

Fig. 3.4.6c Add shading

=% The selected text displays the shading.

=% Now similarly give shading to the second paragraph.

To Remove a Shading.

=% Select the text that displays shading.

=% Select No Colour,
in the Border and Shading
dialogue box.

=& Click OK to remove the

e R R

shading to the document.

82 NotFor Sale - PESRP
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i aﬂmg Fages

' .5 Formng Pages

Just like formatting text and paragraphs, a user can format the pages of the document,
Page formatting includes setting the document margins as well as determining the size
and orientation of the paper A user can also create headers, footers, add page
numbers, insert page breaks and arrange text in columns.

3.5.1 Page Breaks

Word automatically divide the long document into pages with page breaks. This type
of page break is called soft page break or automatic page break.

A user can also insert page breaks at specific location in the document. The page break
that a user insertes Is called a hard page break or manual page break.

WA e b S e Vel T b
Tﬂﬂ.tﬂ'{a e =

i T g

gl e ————

from here. | —_———— - —o
e -

A page break is a point where the current page ends and a new page begins. Inserting
a page break is useful when we want a heading to appear at the top of a new page.

i Iy ChilF*ﬂfih

Chapter = Shiptera

4 L L] L] -
| [
Softpagebreak  Hardpagebresk  Softpagebreak  Hardpagebresk Soft pagebreak
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Formatting Pages

Page Break

=% Open a saved document.

=% On the Home tab, in the Paragraph group,
click Show/Hidebutton el L
This will show paragraph marks and other hidden formatting symbols.

=& Click the place where new page will start.

Ui Lo st bk, the gl bom aciacks maves O
Srwgred W coardmasy wal S ovinill ek of yout
Bcwrvesl Yebi caf e B guienies e ke,
bk, fiasrm, e e pages, e ettt
docrmmt it ek W yuni CinsE puiares
o, o digrEra Py b elinide ;B e
T G ook

Wim AR wmiily vhasgr the drrmiTnng of shieced i
i thet el il by chooning w ook ot e

e o g @ fr fue roc qontty ey
Toe shusngs b orveval] bk ol ‘pomat dhimsrme, choces

[reanile renet irrenasds w thal vou ce alwagn
it tha bk of e dooemes ot neigel
COITRING OF. e ST WA

Fig. 3.5.1 Page break
= On the Insert tab, in the Pages group,
click Page Break.

=& Word adds the page break to the document.
To Delete a Page Break
= Click the Page Break line.

= Press the Ej key to remove the Page Break.
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3.5.2 Section Break

By default, each new document is one section. But a user can easily divide a
document into more than one sections. Dividing a document into sections allows a user
to apply different formats toindividual sections of the document.

R i e
formattedasa | - EesaseemT=.
single column. ree .

A section s a part of a document that is separated from the rest of the document by
section breaks. Fci!uv.ving are the types of section t:-reaks

HmFﬂylﬂmmd _ Emtﬁlmtmmd
AT R 4 £
== P e
B2 e o
5 : |

The Next Page command  The Continuous command  The Even Page or Odd Page |
inserts a section break  insertsasectionbreskand  command inserts a section |
and starts the new ! break and starts the new
section onthe nextpage.  the same page. ~ section on the next even- |
' ! nm-nb-u'edurudd-nmnhered

512 ol

:
£
:
2
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_ Formatting Pages
Section Break
=% Open a saved document.

=% On the Home tab, in the Paragraph group,

click Show/Hide button -

This will show paragraph marks and other hidden formatting symbols.

=% Click the place where new section will start.
=5

On the Page Layout tab, in the Page Setup group, click Breaks.
: ————— ]

T ha i e, cha gRIWTVeE P Sl P O o
deiageid o Ciwrthisiét wadb b everall beok af pes
docaressl. You cas mar e yulieries e cbbs,
andery, focmemn, ben. cvoet pugen wd other
duvuraeil burldieg Shocks. Wt you crosis piciur,
T e iy
e e bk,

o nan ey chazge the drmtong ol st E
= the deererme w2 oy chonang & bk far de
welacred nyur from e i Siyien gallery on the
Tiowtor tahs Vs b Frvmat bl iresty by mning
i rtber irenis un e Flame e bod conini
effer a o af urig the kok £am the cumene
Fuames 34 aing & Neanas it you wpmily dissily

SE Ll e Rt e

Bk e Theeetms pallery mad the Qusch Stvben gallery
[Previde nescl coszrus s dhut e can stwaps
mestarn the ko of Yo Socemen i e origina
omimree 0y ool eeplen

Fig. 3.5.2a Section break

=& The Break diglogue box appears.

=% Click the type of section break we want to add. |

=% Word adds the section break to the document.
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Fig.3.5.2b Section breaks Dialogue box



3.5.3 Inserting Page Numbers

Word can number the pages automatically for a user Numbering pages can help to
make a long document easier to organize when printed.

Inserting Page Numbers

=% Open a saved document.

= On the Insert tab, in the Header & Footer group,
== ]

click Page Number.

O e e e, e gallenes nchade semg St
At il 50 Db b et e wEnall ookl of o
Aoy Vou caa iss o gailorin e o ko,
besclera, fncisry, lame, cowr pagss, nd oiker
e b bibag hiahd Wihin voa chesld ptive
churss, ot disgraims, they she coondneie wid your
s docvraen] lovk

Y cam oy chngs (e Sorwuiibng of sthociod ol
1 the docurrent et by choing & kaok o thet
bid bt A v Qreiks Seles By o e
Hiorne: k. Vo v abse Formaa s dissitly by osing
e ol coctrol o i Home Sb. Mot coabah
Al o checa il Lasiy tha Lok froas dw canean
St or et o Foviell it o ey oot

T chomrngs e cverall bk ol oty doscurant, chanms

Wi 1k Thanmus, pallory el tha Qaick Soylen gabiory
il T corias i Ut e D1 iy

e the bewh 80 voud docament 1 the oegral
cunained (2 prer e b

=% Click Top of Page, Bottom of Page or Page Margins ;'::I“ T:‘ :
am
depending on where we want page numbers to Bl peoe m':t 3
appear in the document. q i :
r Format Page Numbers...
=% Choose a page numbering design from the gallery [ | Remove Page Numbers

of designs. The gallery includes Page X of Y options. Fig. 3.5.3b Page number
gn gallery Pag pti i
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3.5.4 lnsertmg Headers and Faoters
Headers and footers are used to display information on each page of a document.
For example, a user can add page numbers, Date and Time, a company logo, the
document title or file name or the author's name. Headers display information at
the top of each page. Footers display information at the bottom of each page.

Inserting Headers and Footers
=& Open a blank document.

Fig. 3.5.4a Inserting headers and footers
=% Ina View tab, click the One page. |

=% Word can display headers and footers only in the Print Layout view.

=& On the Insert tab, in the Header & Footer group,
click Header and select Blank Header
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=% Type "Computer Applications” , align it right and colour it gray
=& Now select Footer and select Alphabet footer.

=% On the left area type "By Einstein™ and colour them gray.

Fig. 3.5.4b Inserting headers mdfmmzrs

w® Click Close Header and Footer 3 —
or double click the document area. "

Deleting Header or Footer from your Document.

=% Double click the dimmed text for the
Computer Applications
header or footer we want to remove. LT ST e A
=% Drag the mouse over the header or
PEES TR
footer text until all the text is highlighted, = ._]
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=% Then press the L] key to remove the
header or footer from the document. ___ —

=% (Click Close Header and Footer shic
or double click the document area.

Creating Headers and Footers for Specific Pages.

A user can insert pre-designed headers or footers in the document and easily change
the header and footer designs. By using following options, a user can create different
setting of headers and footers on the pages of the document.

] Different first page [¥] Different odd and even pages

Even/Odd Page Header & |

Different First Page

Sometimes we do not

want headers and footers
to appear on the first

Alternatively we may
want to include different
information in the header

or footer for the first

You may also want to
display header a_nd footer

“on odd-numbered pages

~ page of a document for and a different header and
bHC el haﬂﬂg ﬁﬁ_ B Page. : S e g
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Formatting Pages

3.5.5 Inserting Footnotes or Endnotes

Footnotes or endnotes are used to provide additional information about text in the
document. Footnotes and endnotes provide information such as an explanation,
comment, reference, etc.

ttisafootnote. |-

e ———— | (e .

Diﬂisrenca between raamotes and endnﬂt:es

: A met| Page 5 ! d Tl | rez| A Page 3
—_— | e | e | = | =——
T—— : ““:,__ﬂ, :“Tm___ 1| — T
—— —— | | Y——| | —

i e =.----='-.'—.--'='l r MMMMMMM —=

© Inadocument footnotesare & In a document endnotes are | )
raepr'eﬁerrﬁeﬂ'b};_ numbers, for iarwen'case roman mn'nml:, forempie i, l. fii. i
example 1,2, 3. © The text for all the endnates in a document

© Thetextforafootnoteappears | 5000 atthe end of the document.
on the bottom of the page. -
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Footnotes

Retrieve the document Jinnah.docx

=% In Print Layout view, click the location in the document where we want the
number for the footnote to appear. ( on the first line after the word "Jinnah” ).

i b et 1o radia firmah 1 jived dhe Indian
Maticnal Congress. Jired wanied oo s ladis o
Treq couniry b he fousd thl the Coegress
wasied Hisds R in bndia. H then icfi the
Croegreas anad pied Mhustm Lesgae. He
demarded & separuie mute [ Mealiss. On
Magen [4, 19407, Paltistan sppeared on the map
e the workd, When Pairian came o being
[Formah became m frst Governor General. He
died in Karnchi ue Sepiember 11, LR

Fig. 3.5.5a Footnotes

=& On the References tab, in the Footnotes group, |
|

click Insert Footnote.

=% Word inserts the note number and places the insertion point next to the note

number on the bottom of the page.

=i Type the note text ( Muhammad Ali Jinnah ).

Endnotes

Retrieve the document Jinnah.dooc

=% In Print Layout view, click the location in the document where we want the
number for the endnote to appear ( on the first line after the word “Congress” ).
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& free coummry bt be found than the Congress
swatited Hird aj i 1edia. Fe thes lefl e
Conpres ad joined Munlis Lege T
demamted @ sopale sate fin Mindim On
| Augass 14, 1947, Pakistm appeared an the mp
| of the werkl Whe Paliones came s baag
| Yimmak bocame ity Sre Govemor CGeneral He
| e iz Karachi on Sepemnber 11, 194K

I & Party bal bry Hinckss

Fig. 3.5.5b Endnotes

=% On the References tab, in the Footnotes group,
click Insert Endnote.

=& Word inserts the endnote mark and places the insertion point next to the endnote
mark at the end of the document.

= Type the note text ( A Party led by Hindus ).

3.5.6 Changing Margins

A margin is the amount of space between the text and the edges of the paper.
A page has four margins or boundaries top and bottom, left and right. Usually,
the words start at the left margin and keep going until they reach the right
margin. When a user starts a new document, Word automatically sets the
margins to a certain width called the default margin setting. A user can later
change the margins in the document to suit his/her needs.
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Changing Margins

Retrieve the document Jinnah.dooc

T s rufurm b I e foed (ke T
<Pantinal Congroan. foprah wanied 0 e [did
i free cumsrdry bist b foend that tha Coagress
weamted |Ereks Kaj in bnda. Ha then lsh e
Congress wtal prived Muailin Leagas: His
derrandrst & wparew mair for Ml b

‘A 14, 1947, Fakican sppeaned i the
‘o the wreld. When Pakintn carse il ©
LT |being limsah beterne itn first Chrvemar

”I?;III hmuWuwuéE

Fig. 3.5.6a Changing margins

=% In Print Layout view, select all the text by
pressing Ctrl + A
=& Change the font size 20 by using Mini toolbar | I E

“H

"

=% On the Page Layout tab, in the Page Setup group,
click Margins. - |
|

=% Click Custom Margins. R i

g
™

A

L L
LR

 EQOCE
4
RS

EE
3§

g

i

;i‘{ L1

Y

" Botizm: 1™
L Right L
N

Fig. 3.5.6b Page margins design gallery
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iukter: T B e postion Left _ inili
Crientation = [Py T e
(A

Porral  Landgape

SRS P e T

e

Preview ——— s e

=
Fopizio: [Whae doamert |
[ ][ coew ]
Fig. 3.5.6c Page setup dialogue box

Center text on a page
=% Open a blank document.

=h- Type some text.

and bottom margins.

=% In the Top, Bottom, Left, and Right boxes, enter new values for the margins.
wh Click OK to confirm the changes.

3.5.7 Center Text on a Page

A user can center align the text between the top and bottom margins (vertically)
on the page. Centering the text vertically on a page is most often used to create
a cover page for a document.

= In Print Layout view, select the text that we want to center between the top
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Formatting Pages . Unit-3
=% On the Page Layout tab, click the Page Setup Dialogue box Launcher.

H‘Trm—'-—r'*'-r-:

Fig. 3.5.7a Center text verticalfy

=% Page Setup Dialogue box appears.
=% Click the Layout tab. -

[ Margrw | Pagwr | Lot |

=% In the Vertical alignment box, i
click Center. e

= Click OK (oetax... ] [ (o]
to confirm the change. Fig. 3.5.7b Page setup dialogue box




3 5.8 Changmg Page Onenta tron
Page Orientation refers to whether the page is laid out vertically (portrait) or
horizontally (landscape). Mainly, there are two types of page orientations.

Portrait means
paper is taller than
it is wide, It is the
standard page
orientation and is
used to print letters,
memos and reports.

Page Orientation

Landscape
means paper
is wider than
itis tall. Itis
used to print
certificates

and tables.

=% Open a saved document.

=% In a View tab, click the One page.-
=% On the Page Layout tab, click the Page Setup Dialogue box Launcher:l

s e Dismit maby, ther golledien bl bade ibevin hmi aie
b it with the orvsrall look of poer

Yo e cunily charge B formiting ol seiocind bex)
= e docemen iew by casoung 1 ook far ds
iy e T o Quach Svpbe gallivy o e
Heomc . You cas sl forma o drecily by ming
the achier commals ou the Homs tab. Mt conols
et o uheies of asaing he book Troes thet rurremn
T o anry 8 o e e ey drmaly

il chugs thet dweind Wil of yund i mivessl. vhvsian
e T clemisin w the Fage Laywui sh, Ta
changs the ey svaslaiily m ihe Chercc Soyle guilory,
i 1l Chisiges Cuverd Jusih Siyle 51 command
Btk e Theven galiory ol e Cuach Style gaflery
Pt cormmunds an i pee can sheapt
restore v ks al yorar ol o e o gisal
cestaned i1y curren iereplae.

e

Fig. 3.5.8a Page orientation
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Click the Margins tab.

Click Landscape page
orientation.

This area displays a preview >3
of how the document will

—
appear - =———

f——

sesic
=]
Click OK -
to confirm the change. Fig. 3.5.8b Page setup dialogue box
Portrait

O the Insert tab, the galleries inclods items that s
designed to coordingte with the overall leak of yous
docament. You ean e these galleries 1o inser tables.
headers, footers, Mst, eover pages, and other document
building bocks, When you create pictures, charts, or
dixgrams, they slso coondinaie with your currest
docummen| leak,

You can essily chasge the formatting of selected text in
the documnent text by choosing a leok for the selecied
text from the Quick Styles gallery on the Home tab.
Yioru can also format text dircetly by using the other
controds on the Heme tab. Mest contrals offer a chosce
of using the kook from the cwrent theme or using &
format that you specify direcily.

T change the ovenll lock of your document, choose
new Theme elements on the Page Layoal b To
change the looks svailshle in the Quick Siyle gallery,
use the Change Cisrenl Quick Stylo Set command.
Both the Themes gallery and the Quick Styles gallery
jprovvide resed commands g0 that yoo can always restore
the look of your document i the original contained in
your curment iemplate.

Pll‘
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Oin the [mesert tnh, the palleries inchade items thar are designed t coondinate with the
everall look of your document. You can usq thess galleries to insert tables, headers,
footers, liste. cover pages. and other documesi bailding blocks. When you create

pictures, charts, or diagrasms, they also coondinate with your cesrent document look.

“You can easily change the formanting of selecind Sext im the document text by
choosing a look for the selected sext from the Quick Styles gallery on the Heane tab.
‘You can nlso format text direcedy by using the other contrals on the Hiome b, Most
canirols offer a ehoice of simg the book from e oarnent therse or using » format tha
you specify directly.

To change the oversll look of your decumenl, chosss new Theme elements on the
Page Layout tab. To changs the kooks available in the Quick Style gallery, use the
Change Current Chnicie Style Sel command. Both the Themes gallery and the Quick
Sryles gallary provide reset commands so that you can slways restors the ook of your
document 5o the original contained s youw current tomplate.

]

Landscape




_ Formatting Pages

[ ]
3.5.9 Inserting a Watermarik
Watermarks are text or pictures that appear behind the document text. A
watermark can add interest or identify the status of a document.
Inserting a Watermark
=% Open a saved document.

=% |na View tab, click the One page. [

-.-—n.-h =

e T S ———

O i s 1, e pullerion includs e T ow
dhend il coprdratle with The sverall kask ul v

[ ———r
s, -}\J

Ha
5
Tochangs the crecrall book of yeur dacumer,
el aare Therra shemans. on the Pugs Lapaai a8

pafcry. s Charge Camment Gk, Syl S
camerarad. Tt ibe Themes gatary and the Quick
Bale ulary peseila TaH (omanasds &3 thal Yo
et abwuph resiere the kvt of you e i dar

Fig. 3.5.%a Inserting a watermark | —

=% On the Page Layout tab, in the Page |
Background group, click Watermark. i

= A pre-designed gallery of
watermarks appears. —

TREFT L BRaFT T ]

— = o = o
m B
I e R T ———

Fig 3.5.9b Gallery of watermarks
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wh  Click Custom Watermark. - L S ‘




Click Text watermark.

=& Select or type the text
that we want.

Loy v

‘) Iet: | Top Secret ~
Eot: | Time New Roman ~
e
= We can also format the text. Coor: [N 8| [7] Syndransparent
Leyout: (2 Dlagonad O Herizontal
ey JL_ox ][ cocd |

Fig. 3.5.9¢ Printed Watermark dialogue box

=& Click OK to confirm the change.
=& A document with a watermark appears (Fig. 3.5.9a ).
Removing a Watermark
=% On the Page Layout tab,

in the Page Background group, T reasiikasand
click Watermark. J i — =
= A pre-designed gallery of watermarks |
appears. |
i
i
=& Click Remove Watermark. T |
| \
=% Preset watermark will be removed. .
I.. :;-— Y Ll -
—nf%::_ __-_-_‘_;-—_ — _-..I_ —_—
Fig. 3.5.9d Gallery of watermarks
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Formatting Pages

3.5.10 Creating Columns

In a new Word document, text is arranged in one column (single-column) that
spans the width of the page but a user can create any number of columns
(multi-columns). Single-column layouts are commonly used in letter writing or
reports. Multi-column layouts are most often used in newspapers and magazines.

Creating Columns
=» Open a saved document.

=% In a View tab, click the One page.

iy,
M-“hhmﬁ—-ﬁm
carren decuracd lovk.

‘Fou can ey e the Srnaing of sheod ot
i the doscsemue ey chosanng a bk ot the
nchovmd wai frmm the Guick 37pks gallay o the
Flemr inks. Yisi £ sden formal Lex) ey By sarg
tha imher contraly ot Hinres . Ml comrois
offer & b of waing B ok frem the o
therie oF w8 ST dhat o spgeey irecdy

“Mhmuﬂmmh
-wTHH_-kP—LM‘TI

ﬁg. i S.M‘a Creating .ml'ltmm

=& On the Page Layout tab, in the Page Setup group, click Columns.

(==l
=8
] e

=% A pre-designed gallery of columns appears.

=% Select the two columns layout _J

- | MMore Colummns,..

]
] o
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Fig. 3.5.106 Creating columns

3.6 Printing a Document

Printing a document is a simple process. A user can produce a paper copy of
the document by clicking on the printer icon or just press Ctrl + P,

3.6.1 Preview a Document Before
Printing

A user should always preview a document before printing. By doing this, he/she
can correct problems without wasting paper; ink and time.

Preview of a Document Before Printing

=% Open a saved document.
= Click the Microsoft Office Button 3 .
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Printing a Document
=i Office drop-down menu appears.
=% Point to the arrow

+ A Lo T B
next to Print. [ e Wﬂ_
Gy o S DG oguaG Deron petimiy
Dk Primt.
H - Sapd L cpTummers cirectiy b5 the defmet
Srr ey et g (Rangs iy
e
e |
B o
=% Click Print Preview. G
W e >
G ome
- Eyit Word
Fig. 3.6.1a Office drop-down menu

=% The Print Preview window appears

This area it e et
.- dorumrerd. Yo oer e et pifrried kit Lk,

which page

brelins

andite’ It e

Ta e wrvaridl bossi. o' doramend. chacer
Tt e g Lo

ﬂh'fh-i ey med B O Sy pidkivy
i e o I i 0 Ahe
e e book ! e o B s
il frind il WAL

Fig. 3.6.1b Print preview window
=& Now make some changes before print.

=% \When you finish previewing the document, click Close to close the print preview
window.
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3.

.2 Printing Options

Unit- 3

Printing is usually done through the Print dialogue box where a user can use

the following options.

This area mre =
di the e =
pnﬁm:r?sﬂm .I-: o Pl HNPLE a_!Jj
I SR e s |
will print the | Typet P Lasoriet TAIGPCL &
document. —— Wherer  DOTY D Clpret tofie
We can Comment: o [l el el
Fage rarge: ——— Capless -
o T | Mmborotgpes | 8
;i OCmgipne L abeten [ Type the number
printer o) = s Sl i
: ::-T.-.-—_h. e 5. of copies
separated by cormmas counting k 1
from the stirt of the doament o the
Select the print s
range option. Prot et Doaument ] oo e
Pt 1,.,;.;...- B ﬂ Pages per sheet: |1 pae ﬁ
S Sacsle o poper sgm: | o Scsing -
Co ] Com ]

Fig. 3.6.2a Print dialogue box

Print Range Options

: .
All Current page Pages Selection
[ T A N .
|
|
This option prints This option prints | This option prints  Thisoption prints
all pages in the the page containing | the selected pages. the selected text.
document. the insertion point. | (example:1,3,5 or 2-5). |
| |
1 = 1
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_ Printing 2 Document

Paper Size
We use different standard paper sizes for our document, some of them are
listed below:
Paper Size ( inches) Applications
Letter 8.50 X 11.00 Letters, magazines, cataleg_ues
Legal 8.50 X 14.00 Forms, registers, answer sheets
A4 8.27 x 11.69 Letters, magazines, forms, catalogues
As 5.83 x 8.27 Birthday cards
A6 413 x 5.83 Postcards, Eid cards, invitation cards
A7 2.91 X 4.13 Natepads;

To Print a Document
=% Open a document to be printed.

=% Click the Microsoft Office Button @ , point to the arrow next to Print and
then click Print or just press Ctrl + P.

Opens the Properties
=% The Print dialogue box appears. disloguaberiore
printer,
This area ke S s SRR R (1|
displays the i B e S = - }
printer that '—'i_“—‘_._! P Loserdet 30 PCL 6 [ proportes ]
|
will print the e
document. | Whers:  DOT4 002 it o fle
pSaien: Lok |
Fagmrangs —— Copls . 3%
e et on: [ - PRt number
OCmkpse | Sebction | | of coples
Selecttheprint || Spagen M 1 ] cotute g 2
range option. 'I'n-wn.d-:'-l# |
Fron B s fthe documr o e, | ;
_seution, For xample, type 1, 3, 5-{2 | |
“orpisl, plsd, plsd-plicd o iyl ]
Specify theportion | |metwhe: [osomes B[ = = ey
we want to print. commppus Moscug ﬂ.
Lo [ oo
! This area spedﬁﬁ
Fig. 3.6.2b Print dialogue box i the number of
= 1 [ pages we want to
=% Make necessary selections in print dialogue box. b o each
=% Click OK. e e W | sheet of paper.
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Printing a Document  Unit-3

3.6.3 Changing Paper Size and Source

By default, Word uses letter size paper in the document. If a user wants to use
a different paper size then he/she can change the settings.

Paper source is the location from where Word looks for the paper to print the
document. The available paper source options depend on the printer.

Paper Size and Source

=% Open a saved document.

=% In a View tab, click the One page.

=% On the Page Layout tab,
in the Page Setup group,
click the Page Setup Dialogue Box Launcher.

D B Lot tabs, thee galiovies ubuade ds il are:
deigaed o coomlmuie with S cverell ook of your

chirts, ¢ dutgraem, ey ahis soedinee with ymr
e docarr lak.

ira £ wasely chungs e bermung of sl w0
b doucurmod iend by sy @ kot fo the
wbcind e froe dae Quick Seyies gabary o8 the
Hixne sk Yo can sl foresd it duily by sng
gy cogareds o thet Hors iy Mo pespali
affz o chemr ol merg i kaok o I camee:
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Fig. 3.6.3a Paper size and source
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=% In the Page Setup dialogue box, click the Paper tab.

This areacisplays | [ )

the width and L".‘.!:P',!J Papwr Igpﬂl
height of the : -
paper size.

— |
Click the location | - 'ack«:melucatmn. |
G e paper far . ofthepaperfor |
he fistpage of | | o - —--——! S oot

e docum
_=
e
ooyt [Whls docart (eot cppens.. ]
(o] e =)

Fig. 3.6.3b Page setup dialogue box
=% Click the paper size.

=& Under Paper source, click the paper source.
=& Click OK to confirm the changes.

Summary
Print layout view is used to see how the document will appear on a printed page.
Draft view simplifies the page layout so a user can quickly type and edit the document.
Outline view is used to review and work with the structure of a long document.
Full screen reading view is used when a user is reading a document on full screen.
Web layout view is used when a user is creating a web page.
zoom In is used to get a close-up view of a document.
zoom out is used to see more of the page at a reduced size.
Editing text means adding and removing words.
Inserting text means adding new text in the document.
Deleting text means removing text from the document.
Drag and Drop: Drag the selected text to a new location.
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Customizing a Word Document . Unit-3

Clipboard is a temporary area in the memory for storing text and graphics.

Cut means to remove text from the document and place it on the clipboard.
Paste means to transfer a copy of the text from the clipboard to the document.
Copy and Paste means to repeat information in the document without retyping it.
Undo feature is used to discard last changes that have been made in the document.

Redo feature is used to reverse the undo action,
Count words option is used to automatically count the number of pages and words.

Find and Replace command replaces a word or phrase with some other word or phrase.
Thesaurus suggests other words with a similar meanings to the selected word.
Formatting text can enhance the appearance of the document.

Fonts are different styles of writing or typing.

Text colour is used to make the document more attractive and beautiful.
Highlighting tool is used to mark and find important text in the document.

Alignment is the way in which text Is placed between the margins of a page.

Line spacing determines the amount of vertical space between the lines of text.
Formatting paragraphs is the way to organize ideas and adds structure to a document.
Bullet and Number list are small symbols that mark an important line of information (list).
Tab is used to position the text at a specific location in the document.

Tab stop is the location where text moves when someone presses the Tab key

Borders are lines a user can add to the top, bottom or sides of paragraphs.

Shading is a transparent colour or pattern applied to a paragraph.

Page break divides the long document into pages with page breaks.

Section break divides a document into more than one sections.
Inserting page numbers can number the pages automatically for a user,

Headers and Footers are used to display information on each page of a document.
Footnotes or Endnotes provide additional information about text in the document.
Margin is the amount of space between the text and the edges of the paper.
Center Text can center align the text between the top and bottom margins on the page.
Page orientation is layout of the page. It can be vertical or horizontal.
Portrait means paper is taller than it is wide.

Landscape means paper is wider than it is tall.

Watermarks are text or pictures that appear behind document text.
Creating columns can create any number of columns in a document.

Print preview is used to preview a document before printing.

Printing a document prints a paper copy of the document.
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Customizing a Word Document

Exercise
Q.| Tick the correct choice.
i) Word Is a type of software.
a) System b) Application ©) Utility d) Device Driver
ii) view is the best way to see the work in Word.
a) Outline b) Draft c) Print Layout d) Full Screen Reading
iii) A user can view different areas of a long document by. a document.
a) Clipping b) Breaking ¢) Spiitting d) Cutting
iv) Delete key deletes letters from the _side.
a) Right b) Up ¢) Down d) Left
v) Undo feature isusedto ___________last change made in the document.
a) Discard b) Store <) Update d) Save
vi) Word shows the document information (total pages, words) onthe —______bar.
a) Drawing b) Status o) Scroll d) Progress

vii) Changing the width of the lines in a paragraph is known as

a) Formatting b) Spacing o) Indentation d) Alignment

viil) is used to position the text on a specific location.
a) Space b) Backspace o Arrow keys d) Tab

X)) breakis a point where current page ends and a new page begins.
a) Paragraph b) Page ¢) Section ~ d) Line

%) A user can separate part of a document by using break.
a) Page b) Paragraph c) Section d) Line

i) is amount of spaces between the text and edges of your paper.
a) Margin b) Alignment ¢) Border d) None of above
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Customizing a Word Document

xil) Soft page break is also known as page break.

a) Hard b) Long o) Short d) Autornatic
xii) are text or pictures that appear behind the document text.

a) Page Numbers b) Fonts ¢) Columns d) Watermarks
xiv) Always a document before printing.

a) Preview b) View ) Wite d) Read
xv) Is the way in which text is placed between the margins of a page.
a) Numbering b) Pasting ©) Watermark d) Alignment

Q.2 Fill in the blanks.
i) key is used to start a new line in Word.

i) Ctrl + Z is the short key to : the operation.

iii) is the shortcut key to apply Cut option.

iv) Paste means to transfer a copy of the text from the in the
document at the insertion point .

v) alignment is used in the newspapers, magazines and novels etc.
vi) Is a transparent colour or pattern that a user applies to a paragraph.
vil) The print out of the document is known as copy.

viii) The break of the page inserted by a user is known as

page break.
ix) By default lines of a document are spaced.
x) Word allows a user to view a document in views.
Q.3 Define the following.
i) Bullets ii) Indentation iii) Draft View
iv) Dialogue Box v) Page Border vi) Drag and Drop
vil) Shading vill) Section Break ix) Copy and Paste
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;Eu_s'tomizing a Word Document
Q.4 Differentiate between the following.
i) Print Layout View and Web Layout View i} Header and Footer

iii) Zoom In and Zoom Out iv) Page Break and Section Break
v) Cut and Copy vi) Tab and Space
vii) Undo and Redo viii) Alignment and Indentation

Q.5 Give brief answers to the following questions.
i) Describe different document views in Word.

i) What is meant by comment in a Word document ?

iii) How can we find the synonyms of a difficult word in Word ?

iv) Explain the steps to insert Date and Time in Word document.

v) What do you know about Font? Write any three Font names.

vi) What s an alignment? How many ways of text alignment in Word ?

vii) What is indentation? Also differentiate between first line indent and hanging indent.
viii) Define Tab Stop and explain all styles of Tab Stop.

ix) How many page breaks are there in Word 7

x) Describe all the positions where page numbers can be inserted.

Q.6 Match column A with column B and write the matching numbers in
column C,

i) Redo a) Small Letters

i) Copy _ b) Ctrl +Y
iii) Paste c) Capital Letters
iv) Cut d) Delete left to right
v) Spacebar e) Ctrl + V
vi) Backspace f) Thesaurus
vil) Delete g) Delete right to left
viii) Synonyms h) Ctrl + X
ix) Caps Lock On i) Single Space
x) Caps Lock Off pCtri+C
k) Ctrl +Q
DCtrl+Z
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Customizing a Word Document.

Q.7 Match column A with column B and write the matching numbe

column C.
= Ela i o - Bl s - s B Gaeit U

i) Bold a)Ctrl +A

i) Page Number b) Justifying

iii) Orientation c) Hanging

iv) Print Preview d) Font style

v) Italic e) 0.5 By default

vi) Alignment fCri+B

vii) Underlfine 2) Footer

vill) Tab h) Ctrl + U

) Indent i) Landscape

x) Select all ) Ctrl + F2
k) Small letters
) Ctrl+ C

Q.8 Label the following diagram.
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'Customizing a Word Document

Lab Activity ( Editing )

=% Open a new document and save it as "Application”.
=& Type the following text.

= Use the Arial font.

=® Perform the editing and formatting as shown.

b} Place
a Com
e :q______ —— S
To " here.
. ThelPrincipal; _L_ c) Replace with:
\ Gowt. Islamia High School, Heacmgsier
Lahore.
'\_\.ﬁ
Sir
Respectfully, | beg to state that | am sick. ?
Therefor, | cannot come to school. Kindly ¢ d] Justify this
grant me leave for two days. | shall be \ fparagraph
very thankful to you. et
P =t &) bold
| Yours obediently,
g) Right 'J' Shahzad Khan f) Iralicize
"':Fﬂn | Class 7th, A.
l | Roll No. 15
Lab Activity ( Time Table )
= Using Tab key create the following time table for a week.
Monday Tuesday Wednesday Thursday Friday
08:30 English English Science Science Islamiyat
09:15 Maths Maths Urdu Urdu Urdu
10:00 Urdu Urdu Maths Maths English
10:45 Islamivat Islamiyat Islamiyat Islamiyat Science
11:30 Recess Recess Recess Recess Recess
12:15 Science Science English English Maths
01:00 Computer Computer Computer Computer
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Open a new document and save it as “Football Match”,

Add header and footer to this page.

In the header type "Football Match™.
In the footer type your name.

Create two Columns.
Insert the clipart.

—1

|
MNow type a text below the clipart. |
Align it left.

Type "Pak Vs India” in the

pais Pak

, Vs
%/ India

A foothall match Hurry
beginning of the next column and is going to play ..H“:
align it right. hetween wo number of Seats

Asian giants. are available.

=% Change the font size to 82.
Venue: $55, Raza Block, Allama Igbal Tawn, Lahore.
=% Colour them accordingly e s
=&  Now type“Hurry up..........".
w Align it right.
=% Remove spell and grammar errors. c
Lab Activit icket Mat ricket Match
e £e " Pakistanvs Inifia
=% Create a poster for the cricket match -
between Pakistan and India. : ' _gh
=b Use Clipart.

=& Also add header and footer.

=t

Print it out.
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WMult imedia
Prels ntatlons

publish presentations and make ti'rem learning
the art of presenting information. Students will
be able to prepare attractive presentations using
MS PowerPoint.

Learning Outcomes:
After completing this unit, students will be able to:

define multimedia presentation and media elements.
define slide and slide show.

create a new presentaton.

know the types of templates.

use the installed templates.

use text and graphics in the presentation.

use gradient, texture, pattern and picture as a background fill effect.
use an appropriate slide layout.

add text, clipart and drawing to the placeholders

in the presentation.

apply slide transition effect to the presentation.
apply custom animation effects to the presentation.
run the slide show from view menu.
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" unit-4 T

introduction to
Multimedia Presentations

Muitimedia presentations help users to present information visually in an interactive
way. They can use different media elements in their presentations to make an

impact on the audience.

Multimedia

Multimedia is a combination of all or some of the media elements. The elements of
multimedia include text, graphics, audio/video and animation.

Graphics
Digital representation of
non text information such
as drawings, photographs,
Text e een Sounds

are called hics.
Text Is a combination i A wave or vibration which
of letters and numbers can be heard by human

H-latausertypﬁmm; ears is known as sound.
\ / For example, sound of a

passing car gunshot and

Multimedia gy
. L]
Video Animation
A series of pictures that are displayed Animation s a technique used to
one after another along with sound Is createl movement in objects. For
known as video. A video clip is a short example, cartoon programs and
segment of a video. For example, movie animated movies etc.

clips and documentary clips etc.

4.1 Creating a PowerPoint Presentation

Microsoft PowerPoint is a software that helps a user to create attractive multimedia
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Ereaﬁng a PowerPoint Presentation

presentations using different media elements, such as text, graphics, sound, video and
animation. When we start PowerPoint, a new blank presentation begins automatically
with one slide.

Office But Button Quick Access Toolbar  Ribbon Tabs Gr_oup Name Title Bar

l@ﬂl&-.‘}l} /:—-ﬂu u-yéw e :
Nt n—}_!_.p i . > : '_'__]J“__-._.__I-_f_l..._,y;

o AN F—— I— N o — _l__. _.__.....I'a.......__ —
Title Placeholder  Subtitle Placeholder ~ Status Bar Zoom Shider  Slide
Fig. 4.1 PowerPoint window

=% To exit PowerPoint, click close button x| appearing in the top right-hand comer.

4.1.1 Multimedia Presentation

An orderly display of information using different media elements such as audio,
video, animation, text and graphics is known as multimedia presentation.
Multimedia presentations are used to present information to a group of people. It is
the most comprehensive way to present information. PowerPoint and Adobe Flash
are some examples of multimedia presentation software.
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Creating a PowerPoint Presentation

4.1.2 Slide and Slide Show

A single page of presentation created in PowerPoint is called slide. All the information
in the form of media elements such as text, graphics and sound etc. is presented on
the slide. The presentation of all the slides, created in PowerFoint shown one after
another is known as slide show. In the slide show, presentation is shown in the full
screen mode. In the slide show all the graphics, timings, animated effects and

transition effects are shown.
Opening PowerPoint

=% Click Start button.
Point to All programs = Microsoft Office

=" (Click Microsoft Office PowerPoint 2007,
=" PowerPoint 2007 opens.

¥

il o Fryes izl - Tt P ol

e

PR w A
B A A

AR | T

Fig. 4.1.2a PowerPaint 2007

=5 Click on the title placeholder and type "My First Presentation”.

= Now click on the subtitle placeholder and type your name, class and section,

as shown in Fig. 4.1.2(b).
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My First Presentation

Kamran Akmal
Class Tth B

Fig. 4.1.2b PowerPoint first slide ' Slide Show Button
=M Click on new slide button to add few more slides.

=5 Now dlick the slide show button to run the slide show of your presentation or
press F5 key on the keyboard.

= The presentation will run in full screen mode.

=5 Save it in My documents folder with the name of "My First Presentation”.

4.1.3 Blank Presentation

When a user starts PowerPoint, a new blank presentation begins automatically with
one slide, If the user needs to start another blank. presentatinn follow these steps.

Creating Blank Presentation

=& Click office button @and
select New
or Press Ctrl + N.

E—— ]

Fig. 4.1.3a Office menu huiton
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= The New Presentation dialogue box opens.
= Blank Presentation is selected by default.

—

Fig. 4.1.3b New presentation diglogue box |

=®  Click Create button.
=% A new blank presentation will be created.

4.1.4 Templates

A template is a file that contains pre-defined settings on which a user can base new

presentations. Templates are easy to use. They also save much time in beautifying the
slides.

There are three types of templates.

@ Installed Templates: These templates are provided with the PowerFoint.
@ My Templates: Templates that a user has created and saved.

@ Office Online Templates: Templates that a user downloads from Office website.

Using Installed Templates

=% Open PowerPoint (a new blank presentation appears).

=H  Choose office button @ and select New:
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-l The New Presentatfan mak:gue box opens.
= In the Templates list, Click Installed Templates.

Chnii Proin dgium ity Pomaefaiy
7

|
. | — — -

Fig. 4.1.4a New presentation dialogue box (Installed templates)
= Click a template to see a preview of it.

=% (Click Create button.
A new presentation opens based on that selected template.

Fig. 4.1.4b PowerPoint
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4.1.5 Themes

A user can open a new presentation using a theme. A theme contains pre-defined
settings of fonts, colours and effects. A user can also customize a theme by making
changes in fonts and other settings.

Using Themes

=5 Open PowerPoint (a new blank presentation appears).

=™  Choose office button 8) and select New.

=" The New Presentation dialogue box opens.

=t

=% (Click a theme to see a preview of it
= (Click Create button.

In the Tempiates list, Click Installed Themes.

Sl g (PR e
Fesbared
ey

deamnied ootfeliLe
Calencimg
CHME BB
CHsigr 1350
g

Mans
Freianlatien
L]
Firahilui

Riary criegariet

o) )

Fig. 4.1.5 New presentation dialogue box (Installed themes)

=% A new presentation opens based on the selected theme.
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Creating a PowerPoint Presentation Unit-4 ! "

4.1.6 Collecting Contents for
Presentation

Contents for presentation can be collected in the form of text, images, audio and
video clips. The presenter can search books and Internet for the best available
material. Suppose a user wants to create a presentation on Quaid-e-Azam
Muhammad Ali Jinnah.

The user should collect the following material to make an attractive presentation.

@ Textual data (birthday, a brief life history and quotes etc.)
@ Images of Quaid-e-Azam

@ Sound clips from his speeches

® Video clips of Quaid-e Azam

4.1.7 Adding Background Fill Effect

The background of a slide Is the area behind the text and graphics. The background
colour and appearance of the slide can easily be modified with the following effects.

@ Gradient fill: A gradual progression of colours and shades, usually from one colour
to another colour, or from one shade to another shade of the same colour.

@ Texture fill: The feel of a surface or a fabric Is called texture. There are different
textures available in PowerPoint to set as background.

@ Picture fills: A visual representation of an object or scene or person produced
on a surface Is known as picture. For example, paintings, drawings and
photographs etc.

Adding Gradient Fill

=™ Open PowerPoint (a new blank presentation appears).

= Type the following quotation.

" AS YOU SOW, SO SHALL YOU REAP "
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=% On the Design tab, in the Background group,
click Background dialogue box launcher.

2

Click Gradient fill.

Click Preset colours
and select one of the
preset colour styles.

Click Apply to All,

the colour of the background

of the slide changes.
Click Close.

The background of the slide changes.

I
T HS i | Seleoted Fil |
) Ecturs o vman L
[ tice background prachis "‘
- Eraib] Gt En
- EEET=
ol =T 1T I
et { pe==
Enll | e |
B L
I — -

Fig. 4.1.7a Format background dialogue box
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Creating a PowerPoint Presentation

Adding Texture Fill

=% Open PowerPoint (a new blank presentation appears). e
=% Type the following quotation. ; !:;t
"Do good have good" B s
Grid and Guides...

= Right Click on the background of the slide. i e—rig
=5 Select the Format Background.. | et
=% The Format Background dialogue

box opens.
=% Click Picture or texture fill. —
=% Click Texture button and then _|

select the required texture. . “"EE==F
=% Background of the slide is J.

filled with the selected texture.
=» Click ApplytoAll,
=% Click Close.

Not For Sale - PESRP




Addln Plctu as Background Fill

=5 Open PowerPoint (a new blank presentation appears).
=i

=5  Open the Format Background dialogue

box.
Click Picture or texture fill.-

=1

Pchse

Click File button to choose a picture,

Type the quotation * THE SUN SETS IN THE WEST "

Fill

O i

| [© Sraersia
B ¥ ] ¥
Dmm-—ww

Trusgrd
I, froe:

[rm ] [oeews | (S04 |

Set the path of the appropriate picture
which you want to set as background.

[¥] Tie picture g8 teatse

Ty witers:

Ot (0@ = Goea: ':mu__i
Crtfagt 1 |n=| T B ey Imn-q .’J
sgrgent: |Tioen 8]

Mt ki [toew (W

Twaguenzy: )

B

(=== C= =)

Fig. 4.1.7¢ Format background dialogue box

= Click Apply to All =
= -
-
=& Now the picture has been set as

a background.

e axLd

Fig. 4.1.7g Picture effect
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Creating a PowerPoint Presentation

4.1.8 Slide Layout and Placeholders

Layout refers to the way things are arranged on a slide. A slide layout is a ready-made
or pre-defined design of a slide available in Microsoft PowerPoint.

All slide layouts contain boxes with dotted borders called placeholders. These boxes
hold title and body text or objects such as SmartArt graphics, charts, tables, and pictures.
There are different slide layouts available in the PowerPoint. A user can select the
appropriate slide layout for the presentation.

Using Slide Layout and Placeholders
= Open a new blank PowerPoint presentation.

Fig. 4.1.8a A blank presen
=5 A menu of layouts appears.

=b Click the desired layout.

T
Tt

Fig. 4.1.8b Menu of layouis
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| Clickto agd tithe

I Sexiopomiesr

e

Fig. 4.1.8c Title and content layout

=5 In the title placeholder type "My House".
=% |nthe content placeholder, Click Insert Clip Art button.
Clip Art : - x
Search for:
= A Clip Art pane appears. L - [ ]
|
—5  Type "Home" in the Search Fortextbox. |
=» Click Go. The matching Clip Arts appear.
=& Click the Clip Art that you want to insert. <
=5 The selected clip art appears on the slide.
i
8l crpwes o
% Tip @t o Offee Orire
W T by feving s
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Fig. 4.1.8e Adﬂnmhnﬁlg
In the Home tab, on the Drawing group, click Shapes.

Y44

=% Edit the shape, for example by resizing or

moving it as needed.

- A menu of shapes appears.
Click the shape that you want to insert.

aﬁﬁﬂ{}

ﬂ@ﬁ&.ﬂﬂ@@@@@a
e¢oEgar L/7o088
BE@cE@vNHI O
330 1 €5

: Figtiﬁ:fﬁﬁnpemm

My House

=h Save it with the name of " My House”. HR 4.1 "E Aﬂﬂscﬂpm
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4.2 Adding Animations

A user can add animations In a presentation using slide transition and custom
animation effects. These effects help to animate a slide and its objects.

4.2.1 Custom Animation

Custom animation is the list of animated effects that a user can apply to different

selected objects on the slide during the slide show.
Using Custom Animation

=%  Open the presentation “My House".

= Select the image.

=% In the Animation tab, Click Custom Animation,

= C—tilly

Fig 4.2.1a Custom animation menu 1—_

Custom Animation task pane appears.

2

Click Add Effect =» Entrance =» Checkerboard.

¥

Select the Slide Show button _
to view the full screen animation effect.
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We can modify the animation effects on your slide.

[cotomiimation | =
=% In Custom Animation Pane, under Modify task, TR
we can modify three settings of animation effect. I%——ﬂ'-
Start - how to start animation. | e _i!
3 1 T Sywked § =
Direction - direction of animation.
Speed - speed of animation.
=% \We can also remove the animation effect from
the slide by clicking the Remove button. | | [elica s

4.2.2 Slide Transition

Fig. 4.2.1b Custom animation menu

Slide transition Is the movement from one slide to another in the slide show.
A user can add sounds, select the speed and style to the transition effects.

Activity ( My House )

= Open the presentation “My House".

= Add a new slide and type the number of bedrooms, bathrooms and facilities
they have.

Slide |

Slide 2

3%

My House

3Attach Baths
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=i Select the first slide.

=% On the Animations tab, in the Transition To This Slide group, Click a slide
transition effect button to apply the slide transition effect.

My House

Applying sound effects. r
= On the Animations tab, | NTOA | ppmuse
in the Transition To This Slide group, A _
Click Transition Sound. - Breate
Cuméra
Cash Regiter
[a.T T
=% Transition Sound drop-down o
list appears. Dvum g
Entpiatadn
rawaner
Laier
== Select a transition sound. ok
Tyoewoler
VaRape
Wroaih
wing
| Offher Toul x
| Loop upm Wat Song

Fig. 4.2.2b Transition soumnd
drap-down list

B2  Not For Sale - PESRP



Setting speed of the slide transitions.

'_‘- On the Animations tab, E Bomb .
in the Transition To This Slide group, : N Stor '
Click Transition Speed. WioohTons =
! Medium
= Select a transition speed ‘ Fast

from Transition speed drop-down list. A

4.2.3 Run a Slide Show

The presentation of all the slides created in PowerPoint one after another is known as
slide show. In the slide show, presentation is shown In the full screen mode.

Slide Show Slide show starts from the current slide

=) On the Slide Show tab, ) i
in the Start Slide Show group, [ | [ a0
Click From Beginning. 4 Siang Cumeah Shde _ Shde Show -

=% Slide show starts from the first slide.

Summary

@ Multimedia is a combination of all or some of the media elements.
Textis a combination of letters and numbers that a user typeswith a keyboard.
Graphics Is the digital representation of non text information.

@
]
@ Sound is a wave or vibration which can be heard by human ears.

@ Animation is a technique used to create movement in objects.

@ Video clip is a short segment of a video. It is used to support information.

@ Multimedia presentation is an orderly display of information.

@ Asingle page of presentation created in PowerPoint is called a slide.

@ Slide show is the presentation of all the slides one after another

@ Template is a file that contains pre-defined settings on which user can base new presentations.
@ A theme contains pre-defined settings of fonts, colours and effects.

@ Gradient fill is a gradual progression of colours usually from one colour to another.

@ Background is the area behind the text and graphics.

@ Texture fill is a feel of a surface or a fabric.

@ A slide layout is a ready-made design of a slide available in PowerPoint.
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Multimedia Presentations

@ Sslide transition is the movement from one slide to another in the slide show.
@ Custom animation is the list of animated effects that a user can apply to different
selected objects on the slide during the slide show.

Exercise
Q.1 Tick the correct choice.

) A single page of presentation created in PowerPoint is called

a) Slide b) Media o Text d) Slide Show
i) There are elements of multimedia.
a) Four b) Three o Two d) Five
iii) The combination of letters and numbers is known as
a) Alphabets b)Numbers C)Symboails difext
iv) Cartoon movies are the example of. :
a) Painting b) Animation ¢) Drawing d) Photograph
v) The digital representation of nontext information is called
a) Sound b) Video ) Graphics d) Animation
vi) The movement of an object is created by using technique.
a) Animation b) Presentation ¢) Motion d) Bxecution
vii) The name of the PowerPoint file is seen on the bar.
a) Menu b) Title ¢) Scroll d) Status
viil) — s the Keyboard shortcut key to create a new file in the PowerPoint.
a) Ciri+N b) Crh o) Coi+ C d) Cir+P
ix) All slide layouts contain boxes with dotted borders called
a) Titieholder b) Placehoider c) Box holder d) Text holder
x) The presentation of all slides created in PowerPoint is called
a) Slide Design b) Slide View ¢) Slide Show d) Laser Show
xi) Slide are the effects that determine how a slide moves

in and out of the view in the SlideShow.
a) Animation b} Transition ¢) Layout d) Templates
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xii) In which Tab a user can find Slide Transition?
a) Home Tab b) Animation Tab c) Review Tab d) Design Tab

xiil) The list of animated effects that a user can apply to selected object on the slide is

called
a) Smooth Animation b) Long Animation  ©) Slide Transition d) Custom Animation

xiv) An orderly display of information using different media elements is known
as

a) Multimedia Presentation  b) Animation  ¢) Transition d) Layout

xv) The arrangement of the objects on the slide is known as Slide
&) Transition b) Show ©) Deslign d) Layout

Q.2 Fill in the blanks.

0 is a combination of all or some of the media elements.

ii) Picture is an example of

iii) The feel of a surface or a fabric is called

WA isaready-made or pre-defined design of a slide.

v) Placeholders are the boxes with borders. .
vi) is the gradual progression of colours and shades.
vii) A———_contains pre-defined settings of fonts, colours and effects.
vil) A page of presentation created in PowerPoint is called slide.

ix) Slide transition is the movement from one slide to another in the

x) is a wave or vibration which can be heard by human ears.
Q.3 Define the following.

i) Multimedia ii) Placeholder iii) Text

iv) Background v) Animation
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Q.4 Differentiate between the following.
1) Gradient and Texture background Fill i} Graphics and Animation

iii) Video Clip and Animation iv) Installed and My Templates
v) Custom Animation and Slide Transition

Q.5 Give a brief answer to the following questions.
i) What is multimedia? Explain its element.
i) Define Slide and Slide Show,
iii) How can we fill background with different ways?
iv) Explain Slide Layout and its uses in a presentation.

v) What is Slide Transition?
vi) Describe Custom Animation .
vii) What is meant by collecting contents? Explain with an example.

vili) Write the steps to fill background with a picture.
ix) Write the types of the templates.
x) What s a Slide Show?

' Q6 Label the following diagram.

p—

A Cliek to add title J

D

[ Clickto add suirtitle J

g R R e bt
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Q.7 Match column A with column B and write the matching numbers in

column C

a) Application Software
i) Graphics b) Ctrl + N
iii) Gradient c) Letters, Numbers
iv) Slide d) Feel of a surface/fabric
v) Create New Presentation | e) Box with dotted borders
vi) Slide Transition f) Paintings/Drawings
vii) Texture g) Progression of colours
vii) Custom Animation h) Movement of the slides
ix) Placeholder 1) Single Page
x) PowerFoint ) Animated Effects

k) Ctrl + C

DCtri+P

Lab Activity ( Backgrounds)
Open a new presentation.

Select an appropriate layout for the presentation.
Add two more slides in your presentation.

Run the Slide Show.

2R R 5 AR R R 2

Lab Activity ( My Self)

Select different background fill for each slide.

In slide, type your name, class and school name. /
In slide2, type your hobbies. .
In slide3, type the names of your friends.

e

=% Open a new presentation.
=& Select an appropriate layout for the presentation.
=h  Add two more slides in your presentation.
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Lab Activity ( Computer Basics )

LA 2 B 2 AR 2 R R

A

Select different background fill for each slide.

In slidel, type your name, class and school name.

In slide2, type your hobbies.

,

Using custom animation task pane, select .
animation effects for the title and subtitle text.

Bt

e
Apply transition effect from quick style list on the slides. .

Run the Slide Show.

Open a new presentation.

Select an appropriate layout for the presentation.

Add three more slides in your presentation.

Select different background fill for each slide. g

o
In slide |, type the definition of computer. -~

In slide2, type the definition of hardware and software, .

In slide3, type the names of five different hardware.

In slide4, type the names of five different software. :

\-\.

Using custom animation task pane, select animation .
effects for the title and subtitle text.

Apply transition effect from quick style list on the slides.

Run the Slide Show,
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One of the reasons that many people around the world use Internet is e-mail.
[t has become the most popular form of communication. This unit enables the
'-smdenﬁ tocreate and sign -in an e-mail account. They will be able to check,
compose, repfy and sendban’ e-maile, They. will a!so be ab-‘e to recognize

i

different parts of an e-mail message. -, ‘-% B Q%
Learning Outcomes:

After completing this unit, students will be able to:

@ define e-mail.

@ define e-mail account and e-mail address.
define User name and Password.
know that Yahoo mail and Hotmalil offers web based e-mail services.
@ create an e-mail account.
sign-in an e-mail account.
recognize the different parts of an e-mail message.
compose an e-mall message.
attach a file to the e-mail.
send the e-mail.
use Inbax, Sent and Trash folders.
@ check and replay an e-mail.
@ sign-out an e-mail.




5.1 Introduction to E-mail

Sending and receiving messages and files electronically is known as e-mail. A user
can send messages from computer to anyone in the world who has an e-mail
account. People can also attach pictures, programs and sounds with an e-mail.

5.1.1 E-mail Account

Storage area or “mailbox” supplied by an email
service provider is called an e-mail account.
Each e-mall account has a unique address.
E-mail account can be obtained by registering
with ISPs (Internet Service Providers) or e-mail
service providers such as Hotmail, Yahoo and
Gmail etc.

5.1.2 E-mail Address

A unique address of an e-mail account is called an e-mail address. An e-mail address
consists of two parts:

1) User name or ID.

2) Domain ( The name of the computer that stores the e-mail messages),

For example:

Fig 5.1.1 The Mailbox

The @ symbol separates the name
of the person from the domain.

i
‘name@hotmail.com
—r"—‘,—”_‘_' L\-\-\\\'\-\

( Username ofiD J Refers to thr.:l I:IGS'I: computer ]
! where e-mail is stored.

5.1.3 Username

Username is the unique name which a user chooses while creating an e-mail account, It
can be the name of the person or company. It is the first part of an e-mail address. For
example, Ali@hotmail.com. In this e-mail address, Ali is the username.
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Introduction E-mail

5.1.4 Password

A password is a secret word, numbers or both that a user chooses while creating an
e-mail account. A password ensures that only the authentic user can sign-in the e-mail
account. A user can choose his/her birthday, hobby, favourite food or anything that
he/she can remember as a password.

5.1.5 Yahoo mail and Hotmail

The Internet companies or organizations which provide the facility of e-mail are
known as e-mail service providers. There are several e-mail service providers
who provide their services free of cost. Yahoo mail and Hotmail are some of
the most popular and reliable web-based e-mail service providers.

We can access their e-mail services by creating an e-mail account. The web
addresses of Yahoo mail and Hotmail are given below.

www.yahoomall.com
www_hotmall.com

‘-_m e e
L
.'-'n—!’q-_—_ (—n_—-gu--__n—-n

B s s i i sy -

sign in

e e —

S T L3 =
Fig. 5.1.5a Yahoo mail home page

m-mnmmnrm =)

5 iy o B ke St Sl T B - 4 e b 5 g it

Fig. 5.1.5b Hotmail home page
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Sending and Refei‘ving E-mail

5.2 Sending and Receiving E-mail

Sending an e-mail to family and friends is a quick and convenient way to write a
message or letter. Let's explore how to create, compose and send an e-mail.

5.2.1 Creating a Hotmail Account

A user can easily create an e-mail account as several internet companies provide
these services free of charge. Such as Hotmalil, Yahoo and Google etc.

=% Click on Internet Explorer icon 9 i
=% Type www.hotmail.com in the address bar.

=% The Hotmail home page appears as follows,

__" ‘j-“rll_. ok, BAE HOO¥ s e e R |Lrld.i+-l.u--ll
P B Ve Fewtw Tk neb =4 il
e M 1 Fp—— []qn-uu ] o Hott ) Widiem: 30 Wik Marepiaca i_‘]ﬂu-nn

W oy e -.:mm o matat i“_ P - *.ﬂ.‘“-

L%ﬂo\ume
5 Hotmail sign in

The efficent way to do emai

= PPt e wil Miraiot SmartSean thewalagy WA G vl 10
| R e |
= MACAYE waue STl BECmibs m dvie plice " 5
| = |
® RmE pun el PO pur iRdiiE ians a6 ymui pavmenmd?
=] Ramtere: me
e = [Dfmmerctr ry mosvess
EW.II
I Con't have & Hotmail account?

Beaf joa caepate®

Sl i W Lol 10 @0 a1 70 e, Malsege. Niss L-acd S8 ar Misrddaft Oe2 i singha e cage b Egn I WIS

Fig. 5.2.1a Hotmwail home page

= For creating a new account click on Sign up.
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Sending and Recei‘ving E-mail

Create your Windows Live ID

It gets you inta all Window Live services and other places you see
Al Infarmation is required. w *H:"tﬂﬂﬂﬁ:;ngﬁmur'\tj}i?‘? "

Windows Live 1D | 3 | @]live.com |
| Check availability |

Create a Password: I_ l\
B-character minimum; case sensitive

Retype Password: |

Alternate e-mail address: | |
Or chose a security question for password
rest

First name: |
Last name: 1_
Country/reglon: l
State : |

Zip code: |

Gender: [ Male | Female
Birth year: [

Characters: |
Enter the 8 characters you see

m:uhui:mptmuansmatmwmmwmhmnioeawmwmwmm.mlhuwtn
receive e-mail from Window Live, Bing and MSN with service updates, special offers and survey invitatians, You can
unsubscribe at any time.

=% Fill this registration form and click I accept .|

Fig. 5.2.1b User registration form

Not For Sale - PESRP (@30
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Sending and Receiving E-mail

= Finally the following page appears which confirms your e-mail account.
=% You will receive one message welcoming you to Hotmil.

=% Click on the message to read it. Fig. 5.2.1¢ Inbox

=% Hotmail welcoming page appears as follows,

N Hi, arshad! sy, wem | Sasreh your e-mat s
Ak ¥iou have ever-growing storage. Leam mone:

Orafts

¥ To changs the kok of your inbas, pick a

Sant rew theme ffrom the Optons drop-dawn menu.
Delsied

Manage folders 5 3

e What's new with your netwark
account Fm alwh-
A phoca You dorv't have aryone in youf retwork yet, but F you
Today mmmmﬁuﬁunmm

Cortact . For
i » Hew phoios hat theyre sharing

Fig. 5.2.1d Hotmail welcoming page

=% To Sign out or log out of Hotmail.
Click on the Sign out button.
Hotmail will log you out of the system.
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Sending and Receiving E-mail

5.2.2 Parts of E-mail Message

A person with an e-mail account can send and receive e-mail messages in minutes.
Different parts of an e-mail message are given below.

Fig. 5.2.2 E-mail editor

To: In this line, a user type the e-mail address of the person who will receive this e-mail.

Cc: means carbon copy. A carbon copy sends a copy of an e-mail to another person.
This feature is useful when a user wants to send an e-mail to several people at once.

Bcc: means “blind carbon copy” This is similar to the Cc; feature, except that “Bcc.”
recipients are invisible to all of the other recipients of the message.

Subject: In this line, a user writes a description of the message. A user may leave
this line empty but often people do not read e-mails with non-descriptive or
missing subject lines. Examples of descriptive subject lines are “Happy Birthday,
Thank you and Wishing you well".

Attach files: A user can attach files and photos in an e-mail by clicking on the attach
button. :
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Sending and Receiving E-mail

5.2.3 Compose an E-mail

Compose an e-mail means to write a message. A user can compose a new e-mail in
Windows Live Mail by clicking on New button or by pressing Ctri+N from the keyboard.

e Hl_ &I’!hld -I‘d'b_r_ LFe X im ";"ﬂ-“._“- = 3 ﬁl
duri You hawy gwver-growing siorage. Loem mone
Drafa
B & To change the inck of your inbo, pick 2
s i fram the Dntiors dimp-ciosn mer,
Dt
Munage fiders .
iz What's new with your network
i Faarin | Surpeiee me

Fig. 5.2.3 Windovws live mail

5.2.4 Attach a File

Attaching a file allows a user to include a file/photo with an e-mail. A user can attach
Word documents, photos, animations and other type of files with an e-mail.

5.2.5 Send the E-mail

After composing an e-mail, the user has to click on the Send button to complete
the process of sending an e-mail.

I“-_Hﬂ

GH O HRAG Py @ 3-% 8 LA

B/ UFBRESEEAEAY
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Sending and Receiving E-mail

Cnmpou,‘thdrmdﬁadui-ml

=% Open a Hotmail home page.

£ Windows Live
Hotmail sign in
The ellicient way 1o do emall
PARARA AL P A ERD = R
it P o
VRS TP BECER, 7 bt e g s
v . e ey ¥
Tl ok i s s A

Fig 5.2.5b Hotmail home page

\ 4

Click Sign in.

\ 4

Hotmail shows you the Today screen.

K

To compose a new e-mail message in Windows Live Mail,
click on the New or Ctrl + N. |

hew Hi, arshad! surdey, xre = [m_vnrh-l' ﬁ]
Ak You have ever-growing sorage. Leam more
Crafs

¥ To the Inck of your inbow, pick &
Ll rew theme from he Options drop-down menu.
Dwbatact
" What's new with your network
dd g e-mad
account Favories | Gurpriss me

. RV - Yo don't have anyons in your netwark yet, but i you
Today dd some people you'll be abls D see what they're
- T i ulad it by iy
Fig. 5.2.5¢c Windows Live mail
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Sending and Receiving E-mail

Hotmail's e-mail editor appears.

second e-mail address in the Cc: text bax.
Type the subject in the Subject text box.

Type your message.

+4 4

Serd | Sawedraft Atech. | Speliched: Richmt.

i@ wem 0| 3/ UBSRESERREAYS

Type the receivers e-mail address in the To: text box and if required type the

On this auspicious day of B4
“ Eid Mubarik ”

Hotmail
Inbox

Ak

rafis

Garll
Deleted (3)
Marage foiders e e e ———
et 3 -l
oo
Falxted places
Today
Contat ket
Calerclr

Fig. 5.2.5d E-mail editor

=) Now type a letter in MS Notepad and save it in the folder My Documents with

the name of Lettertct
=%  Click Attach button, and select File

Hotmail
From:; P
x anfi345 s@homollcom
cart o)) I
Mirage fbolders | —— T e ————
e AuBwe 03I UBBBEERRAEAYE
feloted piaces Opsit susplciois dy of el
Today “ Eid Mubarik "
Contact et
Calerdar

Fig. 5.2.5¢ E-mail editor ( Attaching a file)
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Sending and Rec.ﬁivjng E-mail

=%  Which opens a Choose file window, where you will select the location of
your file.

ook [ Wy Documrss Q] emom

=H Now select p% :. Ef"
My Documents E_ ]

folder and e e
cuckyuurﬂle_J 2
(Lettertxt)
o
= 5 =
Fesotpps  [MFeal ) =] | | Caed
Fig. $.2.5f Choose file window
w® Click Open.
=d Below the Subject, you will see the filename in the attachment bmt—‘
Hotmail | —-oma | somash dean. s nchime 4 3 | Cocol Svemmrr| |
Froem:
i T L
o [_cc]| wplomnodboemoteom
sant e ]| = —
Deloted (3) Subject: | £id Greetings = s MaE
“'“""‘,:[ ol S R it o PSS NSRS
ot B L e
P phece shalees (D1 iEEEREEASY
;“:nlm : : mu:umuw?rm
Calorcir * Eid Mubarik "
. 5.2.5g E-mail editor (S
wh Click Send. TR e Aanr e

wd After clicking the send button, you will receive a message stating that the
e-mail has been sent to the recipient.
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Sending and Receiving E-mail

5.2.6 Inbox

Inbox is a folder which contains all incoming messages. E-mails are arranged with
respect to Date and Time.

What r u doing? '1:#.\5;:014:

Assignment Glo3jao10

Unitz 19fozf2010
Date ana/;me
Is shown here.

Subject of e-mail
is shown here.

Fig. 5.2.6 Inbox folder

5.2.7 Sent

Sent is a folder which contains all outgoing/sent messages. It maintains the record of all
e-mails that a user sends to different persons.

Mew Delele Markas. Movelb. @ 4
Sparch your e-mall -
0 = usmenmushtag@hotma., RE: Unit 2 19/02/2010

Fig. 5.2.7 Sent folder
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Sending and Receiving E-mail

5.2.8 Deleted or Trash

Deleted e-mails are stored in the Trash/Deleted folder. A user can retrieve a message
from here in case he/she wants to restore it. Following steps are required:

=5 Open your Inbox as one is given in Fig 5.2.8a.

R o
dowes L

ik _ (0 Arif Hasan Assignment1 &lo3/2010
Drafts P 0 usman.mushtag@hotma. Unit 2 14022010

Fielated places
Today
Contact lst

———— Fig 5.2.8a Inbox
=» Check the e-mails, you want to delete.

= Click Delete.
w=h Deleted e-mails are stored in Deleted folder.

g an o-mad

Fig, 5.2.8b Deleted/Trash folder
=% You can restore deleted e-mails within [0 days.
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Sending and Receiving E-mail

5.2.9 Check an E-mail

Check an e-mail means to read the e-mail from the inbox folder. All the received
e-mails are stored in the inbox. A user can check any e-mail from there.

Checking an E-mail
=% Signin an e-mail account.
=¥ Click Inbox.

Fig. 5.2.9 Inbox folder
=% Double click an e-mail to read it

5.2.10 Reply an E-mail

Reply an e-mail means to answer a received e-mail. When a user clicks reply button,
an e-mail editor appears with the e-mail address and subject of the sender The
user can type message and reply the e-mail by clicking send button.

Replying an E-mail
»P Read an e-mail from your Inbox.
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Hotmail New | Dokt Lk | Makas. MoweD. &

,!'ﬁ_m;ﬂ'mﬁ_}_;l_—: 5 e |
|;"——J[ What r u doing?
Drafts From: Kamran Khan (kamrankhanyé@hotmail.com)

@ You may rot know this sender.  Mark as safe | Mark as jurk

e Sertt Friday, e 18, 2010 9:13:49 PM
Delstad | To: amjadaslamB&8@hotmail.com
i - | e e e el
kel 3 e-miadl | AOA, b
o | Amjad how r u7 | have completed my assignmant.
Rt places | heard that you r not studying properdy.
Today What ru doing.......|
Contact list
, 5.2.10 E-mail m
=i Click Reply. L s

=§ A Reply window opens, type the reply message.
=P Click Send. The e-mall is replied.

5.2.11 Sign out an E-mail Account

Sign out means to close an e-mail account. A user can sign out the e-mail account
by clicking the sign out button. -

- Hi, arshad! sundey, ez Search pour a-mad 2|
Ak You have ever-growing siorage. Learn more
Oralle s : ;

# To the look of your inbow, pick &
L rew thami from the Options drop-town men.
Mg Waded 4 P i
o What's new with your network
account Famries | Gurprise me
Aaletud pleces ou dor't hases anpone in your network yet, but if you
Today k] sorer oo you'll be sble i e what they're
Contact st up . For example:

Fig. 5.2.11 Sign out of hotmail
=% To Sign out or log out of Hotmail. Click on the Sign out button.
Hotmail will log out of the system.
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Sending and Receiving E-mail

Summ
Sending and receiving messages and files electronically is known as e-mail.

E-mail Account is a storage area or “mailbox” supplied by an emall service provider.
E-mail Address is a unique address of an e-mail account.

Username is a unique name which a user chooses while creating an e-mail account.
Password is a secret word, numbers or both.

Yahoo mail and Hotmail are popular and reliable web based e-mail service providers.
Cc: means carbon copy. A carbon copy sends a copy of an e-mail to another person,
Bcc: means “blind carbon copy”

In Subject, a user writes a description of the message.

Attaching a file allows a user to include a file/photo with the e-mail.

Inbox is a folder which contains all incoming messages.

Sent s a folder which contains all outgoing/sent messages.

Deleted e-mails are stored in the Trash/Deleted folder
Check an e-mail means to read an e-mail from the inbox.
Reply an e-mail means to answer a received e-mail.

5ign out an e-mail means to close an e-mail account.

Exercise
Q.| Tick the correct choice.

i) Sending and receiving messages and files electronically is known as

a) E-mail b) F-mall ) H-mall d) Gmall
il) Storage area or “mailbox” supplied by an e-mail service provider is called_______.
a) Inbox b) Bank account ¢) E-mall account  d) Commercial account
iiil Is a unique name chosen by a user while creating an e-mail.
a) Login b) Password ) Subject d) Username
iv) The name of the e-mail service provider comes after. sign.
as b)@ o d) #
v) Can two friends have same e-mail address ?
a) Yes b) No c) May be d) No Idea
vi) A user has to click on the button to create a new e-mail account.
a) Sign on b) Sign out ©) Sign In d) Sign up
vil) Cc: stands for
a) Cat Copy b) Carbon Copy c) Cool Copy d) Can't Copy
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viil) Incoming messages are stored in a folder known as

a) Outbaox b) Inbax c) Post Bax d) Mall Bax
ix) E-mails are arranged in inbox with respect to
a) Names b) Date and Time ) Client and Server d) Subject
x) All replied and sent e-mails are stored in a folder.
a) Drafts b) Inbox ) Sent d) Trash/Deleted
i) folder is used to store the deleted e-mails.
a) Drafts b) Trash ¢) Sent d) Junk
xii) All outgoing messages are stored in folder.
a) Inbax b) Deleted ©) Sent d) Drafts
Xiii) means to close an e-mail account.
a) Sign up b) Delete ¢ Signin d) Sign out
xiv) To answer a received e-malil is called an e-mail.
a) Read b) Reply c) Write d) Compose
Xv) is a Keyboard short cut key to compose an e-mail.
a)Cri+P b) Cri+C OCri+N d) Cri+ X
Q.2 Fil in the blanks.
i) Hotmail is a popular—_______ based e-mail service provider.
i A is a secret word, number or both.

jii) An e-mail address consists of username and

vi) ' button is used to include a file/photo in an e-mail.
v) Recipient’s e-mail address is written in — line.
vi) line Is used to write the description of the message.

vii) To open an e-mail account is known as

vill) A and password is required to sign in an e-mail account.
ix) A user can restore deleted e-mails within days.
x) click a received e-mail to read it.
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Electronic Mail
Q.3 Define the following.
i) E-mail Account ii) E-mail Address iii) E-mail Service Provider
iv) Sign In v) Trash/Deleted folder
Q.4 Differentiate between the following.
i) Sender and Receiver ii) Attach and Remove i) Username and Password
iv) Sign in and Sign out v) E-mail address and E-mail account

Q.5 Give brief answer of the following.
i) List down the steps to create a new e-mail account.

i) Write down the procedure to compose and send an e-mail,
iii) Write the names of different folders in an e-mail account.
vi) What is an email address? Give its composition?

v) What is Hotmail and Yahoo mail?

vi) How an e-mail is replied?

vii) What is the function of Cc: feature?

vill) Wrrite the steps to delete an e-mail,

ix) How can we attach a file/photo with an e-mail?

X} Write the web addresses of Hotmail and Yahoo mail.

Q.6 Match column A with column B and write the matching pairs number
in column C.

¥

- SR D s =, a—, 1 i RS i e e T g i
SRy ST T ] 1 .:,?ﬁr&:ﬂﬁffi_-.:ag, T T N WO e R

i) Sign up a) Sent

ii) Sign in b) Secret word

fii) Password ¢) Ali@hotmail.com

iv) Outgoing e-mails d) Carbon copy

v) Deleted e-mails e) Create a new e-mall

vi) E-mail address ) Hotmail

vii) Domain name ) Trash/Deleted

viii) Ce: h) Inbox

i) Incoming messages i) Open an e-mail account

x) Sign out j} Closing an e-mail account
k) Bee:
D) Attach a file
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=P Draw a best wishes card in Paint and save it.
= Sign in your e-mail account.

sign in

Hotmail

The eflicient way to do email

PO e ma Fuer e d
H A et e sl ke

DthlmmMFIEi}

o i cma o wi dl B— My LI P
T

G S Crrre e | b |

g A A e B

g g ey i | ey S Sl

T ——

=) Compose a new e-mall.
= Type best wishes message in the e-mail.
md  Attach best wishes card with the e-mail.

=P Type your best friend’s e-mail address in the “ To: ” text box.

Hotrail Bersl | Bavwdral Aftah.  Spelicherk fchami. | § | Coesl Ml Mg
Fram:

i (=) | umeratomatcom umangyahoacam, chmod@hcemaicom

o 077 | = =

Duertud (3) Subjuct: | Best Wiihes

Maruge fuliers # Tolsyow: 14 9il of WO M

o [ —

Waaaad placed bumveds 0. 3 UFEREERERE A

L HI, friends how are you all? 1 am sending my best wishes to all

Calusder of you for upcaming cricket match,

= Type “Best Wishes” in the Subject text box.

=) Send this e-mail with carbon copy of this e-mail to all other friends.
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Answers

Unit 1 Hardware Basics

Ql

L. (b) Hardware i. (d) System unit

iv. (@) Two v (c) Brain

vil. (b) AL will. (b) CU

*x (a) Permanently «. (b) AGP

xiil. (6) Input xiv.(a) Fingerprint Reader
Q.2

i ALU,CU . Temporary

. Expansion v Electronic

il 154 vill, Laser

¥ Control Unit

Qb

id, g g i), wb, vig, wil |, vill e,
Unit 2 Software Basics

Ql

L (€ Software ii. {c) Operating System
iv. (b) Device Driver v (a) Utility

wvil. (@) Image Viewer vill. (b) Disk Cleanup

® () Educational xi. () Entertainment
xiL (b) ™S Word ®iv.(b) Multimedia

Q.5

if lid, lie, b, va, vicg, wii |, wiil g,

Unit 3 Customizing a Word Document

Ql

i. (b) Application IL () Print Layout
iv. (a) Right v. () Discard

vil. (¢} Indentation wiil. (d) Tab

x () Section L (a) Margin

xiil. (d) Watermarks v, (@) Preview
Q.2

i. Enter ii. Undo

iv. Clipboard v. Full Justification
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iil. (¢} Motherboard

vi. (@ CPU

ix. (b) Random Access Memory
%l (2) Graphics

»v. (d) Robots

xf

iii. Mon volatile
vi. PCI

be. Fingerprint reader

xh

iil. {2} Microsoft Windows
vi. (b) File Manager

ix (d) Application Software
il. (d) Reference

v (b) Devices

xh, x|

li. (c) Splitting
vi. (b) Status

ix. (b) Page
L. (d) Automatic
xv. (d) Alignment

iii, Ciri+Xx
“wi. Watermark



vil. Hard will. Manual

» Five

Q.6

ib, if, e wh, wi vid, vitg, il f ixe,
Q7

if g Wil W) vd b Mih vile ixg

Unit 4 Multimedia Presentations

Q.l

I. (a) Siide il. (d) Five

iv. (b) Animation v. (©) Graphics

vil. (b} Title wiil. (a) Crl + N

% () Slide Show xi. (b) Transition

xiii. (d) Customn Animation v () Multimedia Presentation
Q2

i, Multimedia ii. Graphics

iv, Layout v, Dotted

vil. Theme vill. Single

*. Sound

Q7

ic,c, Wf g ivi, vb, vih,  viid, i}, ixe,

Unit 5 Elecironic Mall

Q.l

i. (a) E-mail li. (€) E-mall Account

4.(0)@ v.(b} MNo

vil. (b) Carbon Copy viil. (o) Inbax

® () Sent i, (b) Trash/Deleted

xill. (d) Sign out ~ xiv. (b) Reply

Q.2

L Web Il. Password

iv. Attach v.To

vii Sign in viil. Username

% Double

Q.6

b Single

xa

Xxa

fii, () Temet

vi. (2) Animation
ix. (b) Placeholder
xii, (d) Design Tab
xv. (d) Layout

i, Texture
vi. Gradient
ix. Slide show

xXa

fil. (d) Username

wl. (d) Sign up

ix. (b) Date and Time
i () Sent

xv. (©) Ctri+ N

iil. Dornain
vi. Subject
ix Ten

e, i, iib, Iva, vg vig vif wiid, ixh, Xx]j
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Add @ Comment: A comment can
be a note, explanation or reminder
that an author adds to a document.
Alignment is the way In which test
is placed between the margins of a
page.

Animation is a technique used to
create movement in objects.
Application software s a set of
computer programs that
enables/helps users to do a specific
work on the computer

Arithmetic and Loglc Unit: this
component of processor solves the
mathematical and logical problems.
Arithmetic Unit & apartof ALU. It
performs addition, subtraction,
multiplication and division.

Attaching a file allows a user to
include a file or picture with an
e-mail,

Bockground Is the area behind the
text and graphics,

Barcode Reader |s an input device.
It gathers Information by reading
barcode.

Borders are lines which a user can
add to the top, bottom or sides of
paragraphs.

Bullet: A buflet is a small symbol
such as a circle or square that marks
animportantline of information.
Cic: means carbon copy, A carbon
copy sends a copy of an e-mall to
another person.

Center Text on a Poge: A user can
center the text between the top
and bottom margins {vertically) on
the page.

Check an e-mail means to read an
e-mail figrm the inbosx.
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Glossary

Clipboard Is a temporary area in
the computer's memaory for storing
text and graphics to reuse.

Copy and Paste means to repeat
information In a document without
retyping it

Control unit fetches the
instructions, interprets them and
directs the ALLl to perform action.
It alse maintains the
sequence of instructions to be
processed,

Custom animotion Is the list of
animated effects that a user can
apply to different selected objects
on the slide during the
slide show.

Cut means to remove text from the
document and place It on the office
clipboard.

Cutting Edge Technology: the
latest or the most advanced stage in
the development of the computer
technology

Deleting Text means remaving text
from the document.

Device driver is a system software
program that tells the operating
system how 1o communicate with a
device,

Disk Sconner s used to resolve
physical and |ogical errors of the
disk. It also create some free space
on the hard disk.

Droft view simplifies the page
layout so a user can quickly type and
edit the document,

Drag and Drop: drag the selected
text to a new location and then
release the mouse button,

Editing text means adding and
remoning wonds.

Educational software helps a user
o learn a particular skill. People use
these software for help and
guidance in different
subjects,

E-mall: Sending messages and files
electronically is known as e-mail

E-mail Account: Storage area or
‘mallbc” supplied by an e-mail
senvice provider is called an e-mail
account.

E-mail Address: A unigue address
of an e-mail account Is called e-mail
address.

Entertalinment software are
developed to entertain users.

Expansion cord k5 a small circuit
board. It enhances the capabllities
ofthe computer

Expansion slot Is a long narmmow
socket on the motherboard Into
which diferent expansion cands can
be plugged.

File manager is used to locate,
rename, delete, copy and cut a file
ffolder

Find and Replace command s
used when a userwants to replace a
word or phrase with something
else,

Fingerprint Reoder is a device that
captures a fingerprint and translates
itinto a digital code,

Font Styles: To emphasize
information in a document, 2 user
can make the text bold, italicize or
underfing.

Fonts: Font is a set of characters (l.e

letters, numbers and symbals} with
aspecific design.

Footnotes or Endnotes provide
additional information about text in



the docurment.

Formatting paragraphs: In
paragraph formatting a user can
organize ideas and add structure in
adocument.

Formatting text enhances the
appearance of the document.

Full screen reading view is used
when a user [s reading a document
on SCreen,

Gradient fill: A gradual progression
of colours, usually from one colour
ta another

Graphics: The pictures/images
displayed by a computer is called
graphics.

Grophics software is used to draw
pictures, 3D images and
animations,

Headers and Footers are used to
display information on each page of
adocument.

Highlighting text Is useful for
marking information that a user
wants to review,

Image viewer is a utllity program
that prowvides an emvironment 1o
view and manage Images in a same
folder or location,

Indent Paragraph: [ndentation
determines the width ofthe lines in
the paragraph,

Inserting Poge MNumbers: Word
can number the pages automatically
for you.

Insert Symbols: A user can easiy
insert symbols into a document
that are not on the keyboard,
Inserting Text means adding new
text in the document.

Landscape means paper Is wider
than itis tall.

Layout refers to the way things are
arranged on asiide

Line Spacing determines the
amount of vertical space between
the lines of text In a paragraph.

Logic Unit ks a part of ALU which
compares two quantities and glve
answer in the fiorm of true or false,

Margin Is the amount of space
betwesn the text and the edges of
the paper

Memory consists of electronic
chips. It stores instructions and data
s0 that CPU can process them.

Motherboard s a main circult
board. All the computer
components are plugged or
connected with it

M5 Word 15 a word processing
software.

Multimedia is & combination of all
or some of the media elements
such as text, graphics, sounds,
videas and animation.

Multimedia Presentation: An
orderly display of Information using
different media elements.
Muitimedia Software helps a user
to create wisual presentations.
Operating System is a collection of
programs that supervises and
controls - overgll functions of a
computer.

Qutline view [s used to review and

work with the structure of a long
document.

Poge Break: Word automatically
divides the leng document into
pages with page breaks.

Page Formatting includes setting
the document margins as well as
determining the size and
orfentation ofthe paper

Poge Orientation: A user can
choose either portrait or landscape
orientation for all or part of the
document.

Poste means to transfer a copy of
the text from the dipboard into the
document at the insertion point.

Picture: A visual representation of
an object or scene or person
produced on a surface (s known as
picture,

Portrait means paper is taller than it
Is wide.

Printing o document: A user can
produce a paper copy of the
document,

Print layout view Is used when a
user wants to see how the
document will appear on a printed
page

Print Preview: A user should always
preview a document before
printing,

Frocessor s the brain of the
computer It carrles out set of
Instructions and processes the data
efficiently and accuratety
Productivity software helps a user
to work more effectively and
efficienth:

RAM Is a temporary storage area for
data before and after it is processed.

Redo feature is used to reverse the
undo action,

Reference softwaore provides a
collection of information on any
topic. This type of software contains
large amount of data.

Robot 15 a machine which Is
controfled by a computer software
stored in chips,

ROM contains start up Ine uetions
of the computer and info, mation
about its hardware devices.

Section Breck means dividing a
document into different sections.

Sent is a folder which contalns all
OUEOiNg/sent Mmessages.
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Shading is a transparent colour or
pattern that a user applies to a
paragraph.

System software b5 programs that
control and direct the operations of
acomputer hardware,

Trash: Deleted e-mails are stored In
the Trash/Deleted folder:

Undo feature is used to discard last

Sign out an e-mall: To close orlog System unit s a case where changes that a user has made in the
out from an e-mall account Is called  processing takes place. It protects  document
sign out an email, the ather Imterral parts of the Litiiities: Litility program s a system
Slide is a single page of presentation ~ COMPUter software which is used to analyze
created in PowerPoint Tab Is used to position text in a  andmaintain a computer
Slide Show Is the presentation of all  SPeciiclocationinthe document.  y;qaq. A series of pictures that are
the slides created, in PowerPoint  Tab stop is the location where text  displayed one after another along
one after another moves when you press the Tab key. with sound is called video.,
Slide tronsition [s the movement Tempiate is 2 file that contains pre-  VWatermarks are text or pictures
from one slide to ancther in the gefinag settingsonwhichausercan  thatappear behind document text.
shde show. base new presentations. Web layout view is used when a
Software Is the set of instructions  Taxt s a combination of lettersand  User is creating a Web page.
to
E"-‘E“ tﬂt:s::ﬂmlﬁlltﬂf‘ Perform a  numbers that a user types with the Word processing software helps a
keyboard, userto produce documents such as
Somd; ::E o2 horm:?:i;m Text colour: A user can change the  leTters, reports, papers and memos.
which heard 1] A
oy colour of text to make a document Zoom in is used to get a close-up
Spiit o document into sections: A mare attractive and beautiful view of the document
user can easily split a document inta
separate sections and each section  11'eMe contains predefined settings :1“"" Out te v 10 988 more- of
of a spiit document contains a copy TN, calaurs and efects. e page atareducedsize.
ofthe entire document. Thesaurus suggests other words
towork with numbers, that a user has selected.
Biblio hy
o 3 e AR . :_7' .
o =L e g S = &
e e R i
Wikipedia www.wikipedia.com Computer Concepts Parsons and Oja
Webopedia www.webopedia.com Introduction to Computers | Peter Norton
TypingMaster | WWww.typingmaster.com Discovering computers 2009 | Shelly Cashman
Answers.com WWW.ANSWers.com Computer Applications Pearson Longman
HowStuffWorks| www.howstuffworks.com | | Computer Basics for Kids Usman Mushtag
Hotmail www.hotmail.com Computing Studies G. K. Powers
Google www.google.com
MSN WWW.msn.com
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A

A4 105

A5 105

AL 105

A7 105

Adobe Fash 3l

Adobe Photashop 3
AGP 10

Alignment 67

Animation 116

ALL &

Application Software 22, 29
Arithmetic Unit &
Automatic Page Break B3

Background 123
Barcode |

Barcode Reader |
Bar Tab 77

Blank Presentation 119
Bold 63

Booting 23

Borders 79
Britannica 31

Bullets &9

C

Ce (Carbon Copy) 145
co/ovD 3, 4

Center AlignTab 77
Check e-mall 152
Clipboard 48

Colurmns 101
Command Buttons 39
Comment 58
Computer 2
Configure devices 23
Copy and Paste 49
Corel Draw 2

CPU (Central Processing Unit) 5

index

Control Unit (CU) 6, 7
Custom Animation 130
Cut 48

D

Decimal Tab 77

Deleted 151

Deleting Text 44

Device Drivers 22,24
Dialogue Box Launcher 39
Disk Cleanup 28

Disk Scanner 28

Domain 140

Draft View 40

Drag and Drop 47

E

EA Sports 2%
Editing Text 44

Educational Software 3l
E-mail 140

E-mail Account 140

E-mail Address 40

E-mail Editor 5
Entertainment Software 29
Even/Odd Page Command 89
Exam Preparing Software 32
Expansion Cards 5, 9
Expansion Slots 5, 10

E

File Management Litility 23
File Manager 25

First Line Indent 72, 73
Find Text 53
Fingerprint 1l
Fingerprint Reader 2
Fonts &0

Font Styles 63

Footers 88

Footnotes 9|
Formatting Text &0

Full justification &7
Full Screen Reading View 40

G

Gmall 140
Google Earth 32

Gradient Fll 123
Graphics 116
Graphics Card 4, 9
Graphics Software 3|
Groups 39

H

Hanging Indent 72, #
Hard Disk 3 4

Hard Page Break 83
Hardware 2, 3
Headers 88

Hotmall 141

|

Image Viewer 25

Inbaoe 145, 150

Indent 72

Indent Both Sides 72, 75
Input/output devices 3,5
Inserting Text 44

154 10

lalic &3

L

Landscape 97
Left Align &7
Left Tab 77
Legal 105
Letter 105

Line Spacing &8
Linux 23

Logic Unit &
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M

Mac OS 23

Managing Programs 23
Manual Page Break 83

Margins 93

Math Skill Bullder 32
Mechanical Agent 13
Memory 5,7

Microsoft Office Templates 120
Microsoft Windows 22
Modem 3,4, 9
Motherboard 4, 5

Moving Text 46

MS Excel 3

™S Paint 31

MS PowerPoint 31, 116

™5 Word 30, 38
Multimedia 1l&

Multimedia Presentation 17
Multimedia Software 3|

My Temnplates 120

N

Metwork Interface Card 9
Motepad 30

O

Office Button 38, 117

Operating System 22
Cutline View 40

P

Page Orientation 97
Paper Size 105
Password 141

Paste 48, 49

PCI 10

Peripherals 5
Personal Computer 4
Picture 123
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Portrait 97

Power Supply 4

Print 102

Print Layout View 40
Print Preview 102
Processor 4,5
Productivity Software 30

G

Quick Access Toolbar 38, 117

R

RAM 4,7

Redo 4%

Reply e-mail 152
Reference Software 32
Ribbon 39, II7

Right Align &7

Right Align Tab 77
Robots 13

ROM 4.8

S

Section Break 85
Sent 145, 150

Shading 8l
Sign in 147

Signout 153
Sgnup W42

Slide 117 118

Slide Show 118, 133
Stide Layout 127
Slide Pane 117

Slide Transition (3|
Soft Page Breaks 83
Software 2, 22
Sound [i&

Sound Card 9
Spreadsheet Software 3
Storage Devices 3,5
Symbols 57

System board 5

System Software 22
System Unit 4

T

Tab 39

Tabs Aligning 76
Tab Stop 77
Template 120
Text |6
Texture Rl 123
Thesaurus 55
Theme 122

To 145

U

Underline &3

Undo 49

Unix 23

LUPC I

Usermname or ID 140
Uitiiities 22, 24

W

Watermarks 99
Web Layout View 40
Windows 2, 23
Windows Explorer 25
Windows Media Player 3l
Windows Picture and Fax
Viewer 25
Windows XF 23
Word Perfect 30
Word Processing

Y

Yahoo mail 141

&

Zoomin 4l
Zoogm Cut 4]

30, 38




Child labour is a curse to the nation. Punish those who employ children.

Punjab Curriculum and Textbook Board provides standard textbooks at low
price according to the approved curricula. Suggestions are requested for
improvement of these books by pointing out any error in spellings, contents, etc.
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